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Introduction
Congratulations on your purchase of FontMonger. We're sure 
your investment will be repaid many times over.

Anyone who has spent hours or days creating a document wants 
the printed result to reflect the effort that was put into it. That 
requires having the right fonts, in the right format, in the right 
application.

However, the continual evolution of font technology has created a 
wide variety of choices rather than a single solution that is best in 
all situations.

FontMonger simplifies your font-related decisions and protects 
your current investment in fonts.

System requirements
• MS DOS/PC DOS 3.1 or later (or DR DOS equivalent)

• Windows 3.0 or greater, in standard or enhanced mode

To use TrueType fonts generated by FontMonger, you will
need Windows 3.1 or greater

• Intel 286,386 or 486 IBM PC or compatible

• At least 2MB RAM

• A floppy disk drive

• 1MB of free hard disk space

A mouse is required for altering characters

Knowledge of Windows
This User Guide assumes that you are familiar with the Windows 
environment, including such operations as:

• starting and exiting programs

• resizing, maximizing, minimizing, tiling, cascading and
closing windows

• using the Print Setup dialog



All of these operations are referred to in the User Guide. Consult 
your Windows documentation if you need more information.

Using the User Guide
The User Guide contains all the information you need to use 
FontMonger effectively.

Chapter 1  provides an overview of what FontMonger can do.

Chapter 2  explains some important concepts used by FontMonger, 
and explains how you use FontMonger to work with fonts.

You should read at least these two chapters to familiarize yourself 
with FontMonger's capabilities.

Chapter 3  is a tutorial which leads you through a typical set of 
font-related activities.

Chapter 4 contains a detailed discussion of converting batches of 
fonts.

Chapter 5 gives you assistance in installing font files produced by 
FontMonger, managing your font files, and transferring fonts to or 
from Macintosh and NeXT computers.

The next three chapters provide detailed step-by-step procedures 
for customizing fonts. You can refer to these chapters as you need 
help with specific operations, or you can read the chapters in 
order to gain an understanding of the challenges involved in 
working with fonts.

Chapter 6  discusses keyboard windows, which you use to 
manipulate groups of characters.

Chapter 7 discusses Alter Character windows, which allow you to 
make changes to individual characters.

Chapter 8  explains how you edit character outlines. This is the 
most powerful method of changing fonts and so is also the most 
complex. You should expect to spend some time becoming 
familiar with the outline editing tools, although some experience 
with drawing programs like CorelDraw, Adobe Illustrator, 
Micrografx Designer or Aldus Freehand will give you a head start.

Chapter 9  is a reference guide to all of FontMonger's menus and 
dialogs.
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Appendix A tells you how to contact the major font vendors. If 
you have questions about your fonts, contact the vendor directly.

Appendix B tells you how to contact Ares Customer Support.

Font copyrights
Creating elegant, useful typefaces is still an art rather than a 
science. It can take years of work by skilled typographers to create 
a single typeface.

Ares Software Corp. supports the efforts of type designers and the 
copyrights they hold in the typefaces they design. We also support 
the efforts and investments of the companies who publish fonts.

We urge you to check the license agreement for your fonts before 
using FontMonger to convert or alter them. If you have any 
questions, please contact the font vendor directly. Appendix A 
contains a list of font vendors and contact information.

Introduction 3





Installing FontMonger

Making a backup
Before you open the FontMonger floppy disk envelope, make sure 
you read the license agreement printed on it. Please make backup 
copies only in accordance with the terms of that agreement.

The floppy disk envelope contains four disks:

• FontMonger Program Disk (3V̂  inch 720KB format)

• FontMonger Program Disk 1 (5 V4 inch 360KB format)

• FontMonger Program Disk 2 (5V4 inch 360KB format)

• FontMonger File Translator for Macintosh (Mac 800KB format)

Use either the 3V2 inch program disk or the 5 V4 inch program 
disks to complete the FontMonger installation, according to the 
type of floppy disk drive you have.

NOTE: Don't attempt to install the File Translator disk on your 
PC. The disk is formatted for  Macintosh systems, and contains an 
Apple File Exchange translator that allows you to share font files 
between a Macintosh and your PC. See Chapter 5 for instructions 
on using the File Translator disk.

Before installing FontMonger, make a backup copy of the 
FontMonger program disks:

1. Use Copy Diskette from the Disk menu in the Windows File
Manager to copy the disks.

If you're not familiar with the procedure for copying disks
under Windows, consult the Windows User's Guide.

2. Label the backup disks you just made.

3. Store the original FontMonger disks in a safe place. Use the
backup copy you just made to complete the FontMonger
installation.

Registering FontMonger
Registering FontMonger is very important — please do it now 
before you install the program. Registration allows us to contact



you about program enhancements and updates. You must also be 
registered to receive technical support.

To register FontMonger, complete and mail the registration card 
found in the floppy disk envelope. No postage is required.

Recording your FontMonger serial number
Copy the serial number from your FontMonger software disk to 
the appropriate blank space in Appendix B of the User Guide. You 
are now ready to install FontMonger.

Running the FontMonger installer
NOTE: I f  you are re-installing or upgrading FontMonger, you 
must make certain that it is not running when you use the 
installer.

1. With Windows running, place the appropriate FontMonger
Program Disk in your floppy disk drive.

If you're installing from the 5 V4 inch disk, start with
FontMonger Program Disk 1.

2. In the Windows Program Manager, choose Run from the File
menu.

3. Type A:INSTALL in the Command Line text box, and click
OK or press Enter. If you placed the FontMonger disk in a
drive other than drive A, substitute the appropriate drive
letter.

4. Follow the instructions that the installer displays.

What the installer does
The installer goes through several steps to install FontMonger:

• It asks you to choose a directory to install FontMonger into. If
the chosen directory doesn't exist, the installer creates it.

• It checks to see if a version of FontMonger already exists in
that directory, and asks if you want to replace it.

• It copies the necessary files to the directory.
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• It creates a new Program Manager group called "FontMonger"
(if it doesn't exist), and creates a FontMonger icon within the
group.

• It runs the Windows Notepad program to display
FontMonger's README.TXT file.

The installer does not alter any of the following system 
configuration files:

WIN.INI
SYSTEM.INI
AUTOEXEC.BAT
CONFIG.SYS

After installation
The first thing you should do after installing FontMonger is read 
the README.TXT file. This text file contains additional 
information about FontMonger that is not in the User Guide.

Optionally, you may also wish to:

• Drag the FontMonger icon to a different Program Manager
group, or delete the icon completely (if you already have an
icon for it, or if you always want to rim FontMonger using a
menu command).

• Create Windows File Manager associations for FontMonger's
document file extensions (.FRF and .FRT). This allows you to
run FontMonger by double-clicking on one of its document
files in the File Manager.

Starting FontMonger
To start FontMonger, simply double-click on the FontMonger 
icon. After briefly displaying a window with its name and version 
number, FontMonger opens its main window.

NOTE: When FontMonger is starting you may notice the Caps 
Lock light on your keyboard flashing. This is normal. FontMonger 
analyzes your keyboard each time it starts to determine which keys 
and key combinations it supports.
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J L
Initially, the main window is maximized to cover the entire 
screen, but you can click on the Restore button at the right-hand 
end of the title bar, then resize it to any convenient size.

Other ways to start FontMonger
You can also start FontMonger in several other ways using 
standard Windows procedures for starting applications. For 
Windows 3.1 these include starting FontMonger:

• By starting an associated file.

• Using Rim from the File menu in the File Manager or Program
Manager.

• From the Startup group — if you want to have FontMonger
rim every time you start Windows 3.1.

• By using the Windows "drag and drop" function.

Technical support
If you need technical support for FontMonger, please refer to 
Appendix B.
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Chapter I. About FontMonger
FontMonger is a Windows application that can convert and 
customize your outline fonts (also known as scalable fonts). 
FontMonger adds value to your existing font collection by making 
your fonts available in more applications and environments.

Why convert?
Fonts come from many different sources. Some may have been 
supplied with your printer, others may have been included with 
applications. Or, you may have purchased font packages from a 
font vendor.

Because fonts from difference sources are often in different 
formats, you may not be able to use all your fonts in all your 
applications. FontMonger converts fonts from their original 
format into other useful formats.

Why customize?
Even if your fonts are already in the format you want, they may 
not be convenient to use. Perhaps your fonts are missing some 
fractions that you need, perhaps you want to convert your 
company logo into a font for easy use, or perhaps you want to 
design an entirely new font.

FontMonger lets you perform all of these customizations, ranging 
from the very simple to the most typographically demanding.

What FontMonger can do
FontMonger can manipulate fonts in many ways. With it you can:

• Convert individual fonts or groups (batches) of fonts from one
format to another.

• Extend fonts by gaining access to characters within the fonts
that are not normally accessible. These are called unencoded
characters.

• Merge characters from several fonts into a single font.

• Alter characters by scaling, slanting or rotating them.

• Add fractions and composite characters such as accented
characters to your fonts.



• Edit character outlines to fine-tune existing characters or to 
create new ones.

• Extend fonts by importing characters from graphics programs.

• Export characters for modification in graphics programs. 

Sources of fonts
There are several sources of fonts you might work with in 
FontMonger:

• TrueType fonts supplied with Windows 3.1.

• PostScript Type 1 fonts supplied with Adobe Type Manager or 
with your printer, or from numerous other sources.

• Intellifonts that came with your printer, with Type Director or 
with Intellifont for Windows.

• Nimbus Q fonts supplied with ZSoft SoftType or 
Zenographics SuperPrint.

• Fonts included with CorelDraw in WFN format.

• LaserMaster LXO fonts that came with your LaserMaster 
printer controller or plain-paper typesetter.

• Bitstream Fontware fonts that you have converted to 
PostScript Type 3 format with the Fontware installer.

• PostScript Type 1 fonts from NeXT computers.

• TrueType and PostScript Type 1 or Type 3 fonts from 
Macintosh computers.

Finding font files
Just knowing that you have a source of fonts isn't enough — you 
must also know where they are before you can convert or 
customize them.

The names of font files are often cryptic abbreviations of the actual 
font names and may reside in directories with equally obscure 
names. FontMonger has the ability to search directories or entire 
disks for font files, and can show you the names of the fonts and 
files it finds.
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Converting fonts
Once FontMonger has helped you find the font files on your disks, 
it can then convert them to any of the following formats:

• TrueType for Windows 3.1.

• PostScript Type 1 for Adobe Type Manager, Bitstream Facelift
and many non-Windows applications (such as Word for DOS,
WordPerfect for DOS and GEM Ventura Publisher).

• Nimbus Q for ZSoft SoftType, Zenographics SuperPrint or
GeoWorks Ensemble.

• PostScript Type 3 for printers that require the Type 3 format.

• PostScript Type 1 for NeXT.

• TrueType, PostScript Type 1 or PostScript Type 3 for
Macintosh.

Hints
Hints are the additional information in outline fonts that assists in 
producing good-looking characters when the fonts are displayed 
or printed at low resolutions or small point sizes.

FontMonger automatically adds hints to fonts whenever it 
produces a font file — as a result of either conversion or 
customization — in TrueType, PostScript Type 1 or Nimbus Q 
formats. FontMonger's hinting can actually improve the quality of 
some fonts.

Customizing fonts
Converting your fonts into different formats is only part of what 
FontMonger lets you do.

You can rearrange characters within a font, or merge characters 
from several fonts into a single font.

Many commercial fonts contain characters that are not normally 
accessible from your keyboard. With FontMonger, you can browse 
through these unencoded characters and assign useful ones to 
unused positions on your keyboard.

If you have artwork or a logo you've designed in a drawing 
application like CorelDraw, Adobe Illustrator or Micrografx
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Slant
£  uperscript

S  ubscript

Designer, you can make new characters by importing the artwork 
into your fonts.

You can also create fractions or composite characters in your fonts. 
The composite characters you create could simply be accented 
characters or might be a combination of several existing 
characters.

Character alterations
Character alterations are ways of modifying existing characters by 
transforming the basic character shapes in various ways.

FontMonger has a number of built-in alterations which allow easy 
creation of small caps or slanted characters, as well as superior 
(superscript) and inferior (subscript) characters from your existing 
fonts.

You can also define your own alterations to change characters in 
exactly the way you need. Your custom alterations can include 
specifications for scaling, moving, slanting and rotating 
characters.

Editing character outlines
When you want to make more basic changes to a character — 
whether by adding, deleting or altering character parts — 
FontMonger provides you with a complete set of character 
drawing tools.

These tools let you change any part of a character by editing its 
outline (the lines and curves that make up the character), or create 
entirely new characters.

FontMonger's outline editing has many of the capabilities of a full 
drawing program, including cut, copy and paste functions, a 
magnifier tool to see greater detail, a pen tool to draw new 
characters and a unique "gizmo" tool for transforming character 
parts.
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Chapter 2. Using FontMonger
The first time you use FontMonger, a window appears covering 
your entire screen. This is FontMonger's main window. Everything 
that you do with FontMonger appears in this main window.

If you don't want the main window to cover the entire screen, you 
can click on the Restore button in the top-right corner of the 
screen. This makes the window smaller, revealing window 
borders that you can drag to resize the window.

In addition, you can minimize FontMonger's main window at any 
time, by clicking on the Minimize button (the second button near 
the top-right comer of the window). This reduces the main 
window and all of its contents to a small icon that Windows 
places along the bottom of your screen.

The main window contains FontMonger's menus — File, Edit, 
Options, Alterations, Window and Help. You use these menus to 
tell FontMonger what actions to carry out on your fonts.

FontMonger document files
FontMonger stores your font data in font document files.

You can best understand how FontMonger uses font document 
files by comparing it with an application like Windows Write, 
which is a simple word processor supplied with Windows.

Write allows you to create text documents — memos, letters, 
reports, and so on. When you want to save this text on your disk, 
Write creates a text document with extension .WRI. This extension 
lets you recognize Write document files when you look at 
directory listings of your disk. Using "associations" in the 
Windows File Manager, you can double-click on a Write 
document file to start the Write application and edit that file.

Similarly, FontMonger allows you to create font documents — 
files that contain information about fonts. The extension by which 
you recognize FontMonger document files is .FRF, and you can 
create an association in the File Manager that lets you double-click 
on a FontMonger document file to start FontMonger and edit that 
font.



The familiar File menu items New, Open, Save and Save As all 
manipulate FontMonger document files, just as the corresponding 
menu items in Write manipulate Write document files.

When you open a FontMonger document file, the font is displayed 
in a window that appears within FontMonger's main window:

This font window is called a keyboard window, because it looks like 
a picture of your keyboard, showing you which characters in the 
font are associated with which keys on your keyboard.

More information about keyboard windows can be found later in 
this chapter, and in Chapter 6 .

Font files
The fonts you already have are in TrueType, PostScript, Nimbus 
Q or Intellifont (or other) formats, and so are not in the form of 
FontMonger document files. The files containing these fonts are 
called simply font files, to distinguish them from FontMonger 
document files.

Opening font files
FontMonger lets you access any font file using Open from the File 
menu, but instead of opening the actual font file, FontMonger 
converts the font and places it into a new FontMonger document. 
The new document is displayed in an untitled keyboard window, 
and your original font file is untouched.
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Building font files
After you have made changes to a font (and, usually, have saved it 
as a FontMonger document file so that you can easily make more 
changes later), you need to build a new font file in TrueType, 
PostScript or Nimbus Q format using Build Font on the File 
menu. This new font file is what you install in Windows 3.1, 
Adobe Type Manager or other type management software.

Converting batches of fonts
FontMonger allows you to convert font files from one format to 
another — either one at a time or in batches of multiple fonts. 
Batches can include font files of various formats.

Choosing Convert Batch from the File menu brings up the 
Convert Batch dialog:
fill; ■■--o. G onye.fi?Bajfe’te?>.* -■ V'

|  Fonts in Batch: |[ GdnvW  Î |

| [Clear :Batch;: J |p.
Ik : 1

flew Format:
| FontMonger |[ijj

The first time this dialog appears, the Fonts in Batch list is empty. 
You add fonts to your batch using either the Find or Add buttons.

Find directs FontMonger to search directories you specify or 
entire hard drives for fonts it can convert. Add provides a 
convenient way to add single fonts to the batch when you know 
the directory in which they are located.

Once you've created your batch, simply choose the format you 
want your fonts to be converted to, and choose OK. FontMonger 
will convert the entire batch without intervention.

I NOTE: When converting between different font file formats, 
FontMonger bypasses the creation o f FontMonger documents. Each
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font is simply read, converted and written into a new font file o f the 
chosen format.

You can, however, add existing FontMonger document files to a 
batch, and you can convert any batch o f fonts to FontMonger 
document files by choosing "FontMonger" as the destination 
format.

FontMonger remembers your batch even after the conversion is 
complete. The next time you choose Convert Batch from the File 
menu, the batch appears again in the Fonts in Batch list. You can 
then remove all fonts from the batch by choosing Clear Batch, 
remove selected fonts from the batch by choosing Remove, or add 
more fonts by choosing Find or Add.

Opening and saving FontMonger documents
There are three ways to open a FontMonger document:

• You can choose Open from the File menu, and open a font file.

FontMonger converts the font and places it in a new untitled 
keyboard window.

• You can choose Open from the File menu, and open a 
FontMonger document that you previously saved.

The title of the keyboard window is the name of the document 
file.

• You can choose New from the File menu, to create a new, 
untitled, keyboard window.

The new font is initially empty (has no characters). You add 
characters to the new font by pasting them from another font, 
by importing them from EPS and Adobe Illustrator graphics 
files, or by drawing them with FontMonger's drawing tools.

You can save a FontMonger document as:

• a normal FontMonger document file with a .FRF extension, or

• a FontMonger document "template" with a .FRT extension.

Document templates are identical in format to a normal 
document file, except that when you later reopen the template
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file, FontMonger automatically makes a copy of the document 
and displays it in a new untitled keyboard window.

Templates are an effective way to create protected documents 
which you can use as the common basis for several fonts.

Working with keyboard windows
Much of the work you do with FontMonger documents will be 
done in keyboard windows:

Character keys Window title Unused keys

Modifier keys Full font name

Each keyboard window corresponds to one FontMonger 
document. If you open an existing FontMonger document file, the 
title bar of the keyboard window shows the document file name, 
and the font's full name appears just below the space key.

If you create a new document (by opening a font file or by 
choosing New from the File menu), the title bar of the keyboard 
window shows you that the document is — until you save it — 
"untitled," and the area at the bottom of the window shows the 
font's full name if it is known.

Keyboard layout display
The keyboard window is a representation of the physical layout of 
your keyboard.

NOTE: There may he some slight differences from the actual 
positions o f the keys on your keyboard. For example, on different 
keyboards, the backslash (\) key often varies in position between the
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I ends o f key rows 1,2 and 4. FontMonger always shows the 
backslash key at the end o f row 2.

When it starts up, FontMonger determines which keyboard 
configuration (US keyboard, US International keyboard, etc) you 
have chosen for your system. In Windows 3.1, you can change 
your keyboard configuration at any time with the Control Panel, 
but if you do so you should restart FontMonger so that it detects 
the new configuration.

On each keycap, FontMonger shows you the character you would 
get by typing that key (when using the font in a text application 
like Write). If the font has no character associated with a key, the 
key uses the System font to show the character it is normally 
associated with, but the character is gray rather than black. Keys 
that can never have a character associated with them are shown 
completely gray.

Keycap with No associated No character
associated character association
character possible

NOTE: The keyboard window only shows keys in the main part o f 
the keyboard. Function keys, arrow keys and other similar keys are 
not shown because they can never have a character associated with 
them. The numeric keypad is not shown because its characters 
already appear in the top row o f the main part o f the keyboard.

When you first open a keyboard window, FontMonger shows you 
the characters produced by "unshifted" keys (that is, produced 
when you press keys without holding down the Shift, Alt or any 
other modifier keys).

You can see the characters associated with "shifted" keys (that is, 
the characters you get when you type keys with the Shift key held 
down) by clicking on either of the keycaps labeled Shift near the 
bottom of the keyboard window. Click on the Shift keycap again 
to return to the unshifted character display.

Similarly, you can click on the Ctrl, Alt or Caps keycaps — or any 
combination of them — to see the characters corresponding to the 
Ctrl, Alt and Caps Lock modifier keys. As before, any key
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combination without an assigned character is shown with a gray 
character on it, and any keycap that can never produce a character 
is shown completely gray.

If your keyboard has dead keys — keys used to form two- 
character sequences that produce single characters — FontMonger 
allows you to access them by clicking on the two keycaps in order.

Character chart display
Your keyboard may not be configured to be able to produce all 
256 possible characters in the Windows ANSI character set. If, for 
example, you need to prepare a font for others to use with a 
keyboard that's configured differently from yours, you may not be 
able to locate all the characters you want.

Rather than trying to find the characters by switching between 
keyboard configurations with the Control Panel, you can instruct 
FontMonger to display all 256 characters by choosing Character 
Chart from the Options menu:
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In the character chart display, FontMonger displays a grid of 16 
rows and 16 columns. (You may need to resize or scroll the 
window to see all the rows and columns.)

In each grid position, FontMonger shows you one of the 256 
characters in the ANSI character set. Below each character is a 
number starting with a zero. This is the number you would type 
from the numeric keypad, while holding down the Alt key, to 
produce that character.
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If you are not familiar with the Alt+numeric keypad method of 
typing characters, refer to your Windows documentation for 
details.

You return to the normal keyboard display by choosing Keyboard 
Layout from the Options menu.

Selecting characters
Before you can carry out any operation on characters within a 
font, you must first select them in the keyboard window.

You select a single character by clicking on its keycap, and select 
multiple characters by dragging over their keycaps. Hold down 
either the Ctrl or Shift key (that is, the real key on your keyboard) 
if you want to extend a selection with further clicks or drags.

You can also select a character by typing it (on your real 
keyboard). When typing, hold down Shift, Ctrl or Alt as 
necessary to get the character you want.

Click in any empty area of the keyboard window, away from any 
keycaps, or press the Esc key, to deselect all selected characters. 
Or, deselect individual characters by clicking or dragging with the 
Ctrl or Shift key held down, or by typing the character again.

Rearranging characters and combining fonts
With FontMonger, you can rearrange fonts by moving characters 
around within a keyboard window, or combine fonts by moving 
characters between keyboard windows.

To make these changes, use Cut, Copy, Paste and Delete from the 
Edit menu:

• Cut and Copy place characters on the clipboard.

• Paste replaces selected characters with characters from the 
clipboard.

• Cut and Delete both remove characters from a font.

You can also use Import from the File menu to import graphics 
and assign them to keys.
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Applying FontMonger's built-in alterations
FontMonger provides four built-in alterations which you can 
apply to selected characters:

Small Caps 
Slanted 
Superior 
Inferior

To apply these alterations, simply select the characters you want 
to change, and choose the appropriate alteration from the 
Alterations menu. Choose Normal if you need to remove any 
alterations that you've applied.

Working with Alter Character windows
In addition to its built-in alterations, FontMonger allows you to 
modify individual characters in a separate window, known as the 
Alter Character window:

Character name

Character origin Advance width

Using this window, you can create your own custom alterations 
and add them to the Alterations menu. You can then use them 
just like FontMonger's built-in alterations.

The Alter Character window also allows you to edit the outlines 
(curves and lines) out of which characters are constructed. You 
can change the shapes of existing characters, or create brand new 
characters.
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You open an Alter Character window by double-clicking on a 
keycap in the keyboard window, or by selecting a keycap and 
choosing Alter Character(s) from the Alterations menu.

The five character-type buttons along the top of the Alter 
Character window are used to construct different kinds of 
characters.

• Click on the Composite Character button to make a composite 
character — one which is made up of other characters. When 
the button is highlighted, you can enter the component 
characters that make up the composite.

• Click on the Diagonal Fraction button to make a fraction with 
a diagonal separator. You enter the characters that form the 
top and bottom parts of the fraction; FontMonger 
automatically sizes and positions them, and places a diagonal 
separator between the parts.

• Click on the Horizontal Fraction button to make a fraction 
with a horizontal separator bar.

• Click on the Normal Character button to change a character 
back to a normal character from a fraction or composite, or to 
end outline editing.

When you open an Alter Character window, one of these first 
four buttons will be highlighted, indicating the type of 
character shown in the window. You need to click on another 
button only if you want to change the character type.

• Click on the Outline Editing button to start editing the outlines 
that make up a normal character. When the button is 
highlighted, all of the drawing tools become active. These 
tools are similar to the tools found in sophisticated drawing 
programs.
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When you're editing character outlines, the displayed 
character changes from a solid, filled view to a hollow outline:

The outline is actually made up of curved and straight 
segments which can be independently sized, moved, rotated, 
slanted and reshaped. Segments can be cut, copied and pasted 
between characters using the clipboard — or you can draw 
new segments.

Altering characters
When a button other than the outline editing button is 
highlighted, you can scale, move, slant and rotate the entire 
character:

• To move the character, simply drag on the character image in 
the display area of the window.

Note that the display area contains rulers and several 
construction lines to help you position characters properly.

To scale, slant or rotate the character, you must first click on it to 
make its handles appear:

Us?

Drag left or right to slant 

• To scale the character, drag one of the square handles.
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• To rotate the character, drag the round handle at the top left.

• To slant the character, drag the round handle at the bottom 
center.

Readouts
The readouts text boxes at the left of the Alter Character window 
show you the horizontal and vertical scale, the position, the 
amount of slanting or rotation and the character advance width of 
the character in the window.
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As you drag the character or one of its handles, the readouts 
change to show you the numerical effect of your drag.

If you prefer, you can type values directly into the readouts 
instead of dragging. Simply click on any of the readouts text boxes 
to activate it, and then type the numerical value you want.

Press Enter to deactivate the text box when you're done.

Undo and Redo
You can undo the effects of any change you make to characters in 
the Alter Character window by using Undo from the Edit menu. 
FontMonger provides eight levels of undo, plus the ability to redo 
your changes, so it's easy to correct mistakes or change your mind 
about how you want your characters to look.

Saving customized alterations
When you've made alterations to a character in the Alter 
Character window, you can create a custom alteration that allows 
you to apply the same alteration to other characters in the font.

Simply choose Customize Alteration from the Alterations menu 
and give your alteration a name. Your alteration will then appear 
in the Alterations menu, and can be applied to characters just like 
the built-in alterations.
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Chapter 3. Tutorial
This tutorial is designed to take you effortlessly through the major 
functions of FontMonger.

Before starting the tutorial, you should install FontMonger 
according to the installation instructions at the beginning of the 
User Guide.

Tutorial files
The tutorial assumes that you installed FontMonger into a 
directory called \fmonger. If you specified a different directory 
during installation, substitute the name of your directory where 
appropriate.

The files used by the tutorial are located in the samples sub­
directory of the \fmonger directory. You should find the 
following files in the samples sub-directory:

itlogo.ai
marks.ttf
prospec.fnt
prospecb.fnt
ticker.fnt

NOTE: These files are for  use in this tutorial only. The fonts do not 
contain complete character sets, so they are not usable as real fonts.
You should not install them in your system.



11:03
am

It's Spring, and that means it's annual report time again at 
Ivory Tower Investment Bankers, Inc. (which is known to 
the world simply as "IT").

You are in charge of Corporate Publishing Services for IT, 
but that doesn't stop everyone from dumping their 
problems on your desk and expecting you to solve them 
right away.

Today's crisis begins when a corporate decision is made to 
move the annual report publishing in-house. You have 
until tomorrow to produce the annual report.

Recently, your department upgraded to Windows 3.1 and 
decided to standardize on TrueType fonts. Unfortunately, 
your corporate fonts are in Nimbus Q, format which you 
can't install directly into Windows 3.1, while the QBlaster 
software you previously used to install them doesn't work 
with Windows 3.1. The soonest you can get an upgraded 
version of QBlaster is next week.

Grumbling quietly to yourself, you open up your Far Side 
calendar software and begin making a list of things to do...

Starting FontMonger
Start up the FontMonger application by double-clicking on the 
Windows Program Manager icon that the FontMonger installer 
created for you.

11:16
am

Your first task is to convert your fonts to TrueType format.

The annual report uses three special fonts: Prospectus 
(your corporate typeface), Prospectus Bold and Ticker 
Tape — a typeface that was designed specially for IT by 
famous typographer Roger Berlin.

You're not sure what you're going to use Ticker Tape for, 
but you know you'd better use a lot of it in the annual 
report somewhere...
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Converting a batch of fonts
You'll begin by converting all of the fonts you are going to use 
into TrueType format. You'll create a "batch" of fonts so that you 
can convert them all at the same time.

1 . Choose Convert Batch from the File menu. The Convert 
Batch dialog appears:

Convert Batch?;

Fonts in Batch: Convert

New Format:___________________
| FontMonger a

2. Click Find. The Choose Directory dialog appears:
tC h 0,0 se D i re cto ry  v

Find fonts in directory: 
c:\fntonger

Directories:
17s* c:\

(monger 
CD samples

Drives:

13 include sub-directories

If you started FontMonger by double-clicking on its Program 
Manager icon, the current directory shown in this dialog should 
already be set to \fmonger. If not, you'll need to use the 
Directories list to navigate to the fmonger folder.

3. Double-click on samples to make it the current directory.
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4. Click OK.

FontMonger examines all the files in \fmonger \samples, 
finds four fonts and displays them in the Add to Batch dialog:

Fonts Found:
M arks (T lu e T y p e )- \ :
P ro sp e c tu s  Bold  (Nim bus Q) 
P ro sp e c tu s  R eg u la r; (N im bus Q 1 
T ic k e r  T a p e ;P la ih JN im b u s ;Q )

O  List by File 

®  List by Font

List Fonts of Type: I All Formats

Notice that Marks is already a TrueType font, so you won't need 
to convert it.

5. Hold down the Ctrl key and click on the entry that reads 
Marks (TrueType). Marks becomes unselected while the 
other three fonts remain selected.

6 . Click on the Add Selected button. The three selected fonts are 
added to the batch and appear in the Fonts in Batch list of the 
Convert Batch dialog:

|T,3e^eTJ
New Format:

| FontMonger |

7. Drop down the New Format list by clicking on its down- 
arrow and select TrueType from the list.
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8 . Click Convert. The Choose Directory dialog appears:

Put converted fonts in directory: 
c: \f mongerVsamples

|_______OKiJ
I Cant? 1

Drives:

0^ c:\
(?=i fmonger a

I jjewDirectoty |

It's best to create a new directory for the converted fonts, so that 
you can keep them separate from the originals.

9. Click New Directory. The Create Directory dialog appears:

Current Directory: 
C:\FMONGER\SAMPLES

Name:
Lj»gB§g[̂ )

10. Type itfonts in the Name text box and click OK.

In the Choose Directory dialog, you will see that \fmonger 
\samples\itfonts is now the current directory.

11. Click OK to start the conversion process.

During conversion, a progress dialog shows the steps FontMonger 
follows to convert each font — reading the source font file, hinting 
the font, and building the destination font file.

You have now converted the three fonts to TrueType format. The 
new font files are tickel.ttf, prosp2.ttf and prosp3.ttf in directory 
\fmonger\samples\itfonts. FontMonger assigned these file 
names during conversion, based on the full font names of the 
fonts. The TTF extensions indicate TrueType format.

NOTE: The numbers in the file  names represent the order in which 
FontMonger converted the fonts. I f FontMonger converted your 
fonts in a different order from the one shown here, the numbers will 
be different.
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am

Your next task is to create a small caps version of Ticker 
Tape.

After last year's annual report was printed, someone 
complained that the small caps used for the disclaimer 
information were simply capital letters in a smaller point 
size.

As a result, you got a memo insisting that this year's 
annual report must not repeat the same mistake.

You still have the memo on your desk. You can even 
almost read it through the coffee stains...

Opening a font
Before you can do anything to the Ticker Tape font, you must 
open it:

1. Choose Open from the File menu. The Open Font dialog 
appears:

2. The current directory should still be \fmonger\samples 
\itfonts. If not, navigate to the itfonts directory.

The File Name list shows the three files that were created as 
the result of the batch conversion you did earlier.

3. Click on tickel.ttf to select it. The full name of the font, Ticker 
Tape Plain, appears in the Fonts list.
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4. Click OK to open the font.

When the font has been opened, you will see its keyboard 
window:

The title bar of this window says "untitled-1", which tells you that 
FontMonger has copied the font file into a new FontMonger font 
document. The changes you are about to make will affect this new 
font document, leaving the TrueType font file untouched.

The full name of the font — Ticker Tape Plain — appears at the 
bottom of the keyboard window.

Altering a font — creating small caps
Creating a small caps version of Ticker Tape requires a little 
advance planning.

You are going to use the regular capital letters from Ticker Tape to 
make the small capital letters. But small caps are usually used in 
place of lowercase letters — full-size caps are used along with small 
caps:

Without small caps One Two Three
With small caps Q n E  T W O  TH REE 

So, you must be careful to preserve
the uppercase letters, and change only the lowercase. You will do 
this by making a copy of the uppercase letters.
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1. Choose Select A-Z from the Edit menu. The keycaps for the 
uppercase letters are now highlighted to look as if they've 
been pressed down, indicating that they are selected:

Notice that the Shift keycaps in the window are also highlighted.
This reflects the fact that you hold down the Shift key on your
keyboard whenever you want to type an uppercase letter.

2. Choose Copy from the Edit menu. This places a copy of the 
selected characters onto the clipboard.

3. Now choose Select a-z from the Edit menu. The uppercase 
letters are deselected and the lowercase letters are selected 
instead:

The Shift keycaps are no longer highlighted, since you type 
lowercase letters without pressing the Shift key.

4. Choose Paste from the Edit menu.
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Since there are already characters on the selected keycaps, 
FontMonger asks you to confirm that you want to replace 
those characters. Click Yes to replace the lowercase letters 
with a copy of the capital letters.

Now you can turn the lowercase letters into small caps.

5. The letters you pasted should still be selected. If they're not, 
choose Select a-z from the Edit menu again to select them.

6 . Choose Small Caps from the Alterations menu. You can see 
the characters on the selected keycaps change as FontMonger 
turns them into small caps.

You can compare the small caps to the full-size caps by clicking on 
the Shift keycap.

The font now contains the small caps you want, but there's 
another important change you need to make — you have to give 
the font a new name.

7. Choose Set Font Information from the Options menu. The 
Set Font Information dialog appears:

Family Name:

Font Style/Weight flame:
Plain

Stroke Weight 

Font Width:

Family Relationship:

Family Metrics: 
Ascent: |0 |

Descent: |0 |

Line Gap: |o |

| Normal

| Plain member

a
a
a

' Font Classification: ” 
IEI Sans-serif 
D Decorative

The Family Name text box shows Ticker Tape, which you don't 
want to change, but the Font Style/Weight Name text box still 
says Plain. Unless you change this name, your small caps font will 
have the same name as the original Ticker Tape font, which will 
cause a problem when you install both fonts in Windows 3.1. You 
also need to make sure that Windows will realize that this is not 
the "normal" Ticker Tape font.
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8 . Type Small Caps in the Font Style/Weight Name text box.

9. Choose Other family member from the Family Relationship 
drop-down list.

10. Click OK. You can see the new font name at the bottom of the 
keyboard window.

Saving a font
Since you've done some significant work on your font, you'd
better save it on disk:

1. Choose Save from the File menu. Because the font is untitled, 
the Save As dialog appears so that you can specify where you 
want it saved:

File Name:
B
p io sp 2 .tif
p ro sp 3 .tif
t ic k e l.t t f

in

Directories:
c:\fmonger\samples\ilfonts

PY c:\
&  fmonger 
&  samples 

itfonts

Save File as lyp e:___________
[FontMonger (.FRF] |

Drives:

a

2. Type tickersc in the File Name text box. Don't type an 
extension, because FontMonger will supply the correct 
extension (.FRF) automatically.

4. Make certain that the current directory is still \fmonger 
\samples\itfonts. If not, navigate back to the correct 
directory.

5. Click OK. The small caps font is saved as a FontMonger 
document file with file name tickersc.frf.

You're done with the small caps font for now. (You still have to 
build a font file that you can install into Windows 3.1, but you'll 
get to that later.) Choose Close from the File menu to close the 
keyboard window.
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Your assistant has been working for three weeks on the 
financial tables that are to appear in the annual report. 
You're not sure exactly what's taking him so long, but after 
giving the matter some thought you decide you'd rather 
not know.

Now he comes into your office and starts complaining.
You can't help feeling that your assistant does a lot of 
whining these days.

Once you start listening to what he's saying, you hear that 
he just received an email with some last minute changes to 
the tables which require a one-quarter fraction. Your fonts 
don't have a one-quarter fraction.

Suddenly you feel like whining too...

Creating a fraction
When you created small caps, you made an entirely new font. This 
time you're going to create a new version of Ticker Tape Plain.

1. Open file tickel.ttf again, just like you did before you created 
the small caps font. As before, FontMonger makes a copy of 
the font and displays it in an untitled keyboard window.

Since you know that the annual report doesn't have any brackets 
in it, you'll replace the left bracket with your one-quarter fraction.

1. Double-click on the [ keycap in the keyboard window. 
FontMonger opens an Alter Character window:
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2. Click on the Horizontal Fraction button (the third button in 
the horizontal row of buttons near the top of the window).

Two text boxes appear just above the button so that you can enter 
the parts of the fraction.

FontMonger automatically puts the number 1 into the Fraction 
Top text box and selects the text to show that the text box is active. 
Since the number 1 is exactly what you want, you only have to 
change the bottom part of the fraction.

3. Press Tab to activate the Fraction Bottom text box. Since there 
can only be one active text box at a time, this makes the 
Fraction Top text box inactive.

You can also activate a text box by clicking on it.

4. Type 4 in the Fraction Bottom text box. The character display 
area of the window shows an enlarged view of the fraction:

5.

6.

Fraction Top 11

Bottom I R T

Width 100C,
•SHettf 1tE ’ «-*fcp

Horizontal lip
* Vertical ’•BSS
Slant cr v, • fill
Rotate 0 I BChar Width !338 -ps i !
Context' - 5- a-. !»

-S J

1

7.

8.

Close the Alter Character window by double clicking on the 
system menu icon at the left end of the title bar. You'll see 
that the [ key now shows the fraction |.

Close the keyboard window, too. Double-click on its system 
menu icon, or choose Close from the File menu.

Since the keyboard window represents a new font document, 
FontMonger asks you if you want to save the document.

Click Save. FontMonger then asks for the file name to use for 
the new font document file.

Type ticker. FontMonger supplies the .FRF extension and 
saves the font.
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• • 20 
pm

Just as you're about to leave on a long lunch break — 
maybe 2 0  minutes or so — a courier arrives with a disk 
containing the new IT logo artwork.

You'd forgotten about the new logo.

You realize that you could save quite a lot of time in laying 
out the annual report if the new logo was a character in a 
font. You would then be able to place it with a single 
keystroke, instead of having to import the artwork file at 
all the places where the logo occurs.

You try to tip the courier, but she gives the money back to 
you, saying that she doesn't accept small bills...

Importing a logo
You'll put the logo into the version of Ticker Tape Plain to which 
you earlier added the fraction.

1. Open the file ticker.frf. You're opening a FontMonger font 
document file, so the keyboard window isn't untitled this 
time — the window's title bar shows the document file name.

Since you already used the left bracket for the fraction, you may as 
well use the right bracket for the logo.

2. Click on the ] keycap in the keyboard window to select it.

3. Choose Import Character from the File menu. The Import 
Character dialog appears:

File Name:

prosp2.ttf
prosp3.tif
tickel.ttf
ticker.frf
tickersc.frf

List Files of Type: 
[All Files (” )

£1

Tm pjfrt G h aib  cte r  #

Directories:
c: \f monger\samp!es\itf onts

tr^ c:\
fmonger 

(?=> samples 
&  itfonts

Drives:

a

1
 ̂Canfcel' - ]

The current directory is probably still \fmonger\samples\itfont. 
The logo file is in the parent directory \fmonger\samples.
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4. Double-click on the samples directory name in the 

Directories list to make it the current directory.

5. Double-click on the file named itlogo.ai in the File Name list.

Double-clicking on a file name is a shortcut that has the same 
effect as clicking on the name to select it then choosing OK.

When the import is finished, you'll see the logo appear on the ] 
key. Because the keycap is small, you can't see the logo very well. 
If you want to examine the logo more closely, double-click on the ] 
key to open an Alter Character window, which will show you an 
enlarged view of the logo. Close the Alter Character window 
when you're done.

There's only one thing left to do:

6 . Save the font by choosing Save from the File menu.

11 
p m

Lunch was California cuisine — 5 grams of Vitamin C 
washed down by a bottle of mineral water. This is the 
healthiest food you've eaten in a week.

Physically refreshed, you return to work. With a vague 
plan of anticipating the next problem to walk into your 
office, you decide to check the Ticker Tape font yourself.

You print six laser printer test pages, and sure enough 
there are more characters missing from the font. The 
trademark symbol, the registered trademark symbol and 
— inexplicably — the dollar sign are all missing.

The sixth test page is also missing. It seems to have got lost 
somewhere inside the laser printer, but you know better 
than to try to find out what happened...

Creating a dollar sign
A dollar sign looks very much like a capital letter S with a vertical 
bar through it. Since the Ticker Tape font already has a capital S, 
you'll use that to create the dollar sign.
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First, copy the capital S onto the dollar sign key.

1. Click on either of the Shift keycaps in the keyboard window 
to show the characters that are typed when the Shift key is 
held down.

You'll see Ticker Tape's S in its usual place between A and D. 
Notice also that the fifth keycap in the top row has a gray 
dollar sign on it.

This means that the keycap is the normal position of the 
dollar sign, but that there is no dollar sign assigned to it.

2. Click on the S keycap to select it, and choose Copy from the 
Edit menu. This places a copy of the S onto the clipboard.

3. Click on the $ keycap to select it and choose Paste from the 
Edit menu. A copy of the letter S appears on the $ keycap.

Now you'll draw a vertical bar through the S with FontMonger's 
drawing tools.

4. Double click on the $ keycap to open the Alter Character 
window.

5. Click on the Outline Editing button (the fifth button in the 
horizontal row of buttons).

The character isn't shown black-filled any more. What you're 
seeing now is the underlying character "skeleton."
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6 . Activate the pen tool by clicking on its icon in the toolbox (the 
second tool in the vertical column of tools).

To draw the vertical bar, you will click five times with the pen 
tool: one time to start the outline of the rectangular bar, then once 
for each of the four sides.

7. Move the mouse pointer just below the base of the S, a little to 
the left of center, and click.

A small "starburst" shape appears where you clicked. This is 
the first comer of the rectangle.

8 . Move the mouse pointer about the same distance to the right 
of center and, holding down the Shift key on your keyboard, 
click a second time.

A short line connects the two places you clicked. As before, a 
starburst marks the end of the line you just drew.

Holding down the Shift key forces FontMonger to draw a 
line that is exactly horizontal.
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9. Move the mouse pointer straight up to the top of the S.
Holding down the Shift key again, click just above the top of 
the S. This time, the Shift key gives you a line that is precisely 
vertical.

10. Move the mouse pointer to the left of the center of the S and 
click, once again with the Shift key held down.

-SO0 ^0 . soo ^000 jlSOC ♦

% s J

♦
* u . l+i

11. Move the mouse pointer back down to the place you started, 
and click on the first point in the rectangle.
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You don't have to be exact. When the pointer is over the first 
point of the rectangle, the point "lights up" with a big black 
circle.

As long as the point is lit up, your mouse pointer is in the 
right place.

Unless you were very lucky, the last line you drew isn't exactly 
vertical, but that's easy to fix.

1 2 . Activate the arrow tool by clicking on its icon in the toolbox.

13. Press and hold the Shift key, then drag the top left comer of 
the rectangle to the left or the right until the left side of the 
rectangle is exactly vertical.

f500 ( i 1?0,0 , , i 1®00

. Current X .. 210
CuffentY WOU'
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Just as when you first drew the rectangle, the Shift key forces 
the top of the rectangle to stay exactly horizontal.

Although you've done the hardest part, you're not quite finished 
yet.

The rectangle you just drew overlaps the S shape. Unfortunately, 
characters with lines that cross will not print correctly. (The 
software that drives your printer relies on the fact that there are 
no crossing lines, in order to simplify its mathematical 
calculations and thus speed up the printing process.)

You could use the scissors tool to cut the character up into pieces 
and remove the parts that overlap, but luckily there's an easier 
way.
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14. Choose Merge Outlines from the Edit menu. Then sit back 
and watch FontMonger do all the work for you.

15. Close the Alter Character window.

You've probably anticipated the last step, which is:

16. Save the font by choosing Save from the File menu.

This time, since you're saving an existing font document, 
FontMonger doesn't need to ask you for the file name.

Copying and pasting between fonts
The Ticker Tape font is almost complete. It's still missing the 
trademark and registered trademark symbols, but you have them 
stashed away in the Marks font.

1. With the Ticker Tape keyboard window still open, choose 
Open from the File menu and open the marks.ttf file in 
directory \fmonger\samples.

You now have two keyboard windows open — one for Ticker 
Tape and one for Marks.

°l TTCKiBJRF  ̂ It!:±

Look carefully at the Marks window. All the keycaps have gray 
characters, meaning that all those characters are missing from the 
font. Click on a Shift keycap. All those characters are missing from 
the font, too.
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In fact, if you're using the standard U.S. keyboard configuration, 
you won't be able to find any characters anywhere — the only two 
characters in the font (™ and ®) aren't assigned to keys on the 
U.S. keyboard!

But there is a way of getting the characters:

2. Choose Character Chart from the Options menu. (Make sure 
that the Marks keyboard window is in front of the Ticker 
Tape window when you do this.)

Instead of the usual character layout, FontMonger now shows 
you a chart of all 256 possible characters in a Windows font, 
arranged into a grid of 16 rows and 16 columns.

T IC K E R .rR F

| tiSSE* ̂ £̂ 95 £2

iiiK:iiiiK>:ifiitrntnRTiiiiit̂ inic«iriiRinnr>.itnt:HiitkMii>K:iriTiisirTitiinitiiiiimiiinei
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0 14 4  0 1 4 5 1 0 1 4 6  0 1 4 7  0 14 8  0149

. i l  i l l  j J  i l l  1 3  $ 1  s i  >-
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0 155  0156
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01591
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You can resize or scroll the window to see all of the 
characters. You'll find ™ in row 9, column 9 and ® in row A, 
column E.

3. Click on the ™ keycap to select it, then hold down the Ctrl 
key and click on the ® keycap to select it too. (If you don't 
hold down Ctrl, ™ will be deselected when you select ®.)

4. Choose Copy from the Edit menu.

You'd like to have ™ and ® easily accessible from your standard 
U.S. keyboard, so you'll replace the { and } characters, which you 
aren't likely to use. The { and } characters are assigned to the same 
keys as [ and ], which you replaced earlier, except that they 
require the Shift key to be held down.
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5. Click on the Ticker Tape keyboard window to bring it in front 
of the Marks window.

6 . Click on the Shift keycap to select it. The { and } characters are 
now displayed in the second row of keycaps.

7. Drag from the { keycap over the } keycap. This is an easy way 
to select multiple characters.

8 . Choose Paste from the Edit menu, and reply Yes to 
FontMonger's confirmation message. The ™ and ® characters 
now replace the { and } characters on the selected keycaps.

9. Save the Ticker Tape font by choosing Save from the File 
menu.

10. Close the Marks window. Choose Don't Save when 
FontMonger asks if you want to save it.

45 Your assistant rushes back into your office and starts 
talking at you very fast.

As far as you can tell, he's trying to tell you that he has 
finished the financial tables, but he has to leave work in 
fifteen minutes to collect a pair of tickets for tonight's (and 
tomorrow night's and the next night's and the next night's) 
performance of the operas in Wagner's "Ring" cycle, so he 
needs the final version of the Ticker Tape font right away.

You look at him calmly for a long moment, to show him 
how it's done, then tell him, "Just wait for a minute."

You sincerely hope he'll be quiet while he's waiting...

Building a font file
Your customized fonts — Ticker Tape Plain and Ticker Tape Small 
Caps — are now complete. All that remains is to build the 
TrueType font files that you will install into Windows 3.1.

1. Open a keyboard window for Ticker Tape Plain, if it isn't still 
already open.
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2. Choose Build Font from the File menu. The Build Font dialog 

appears:

3. Type ticker in the File Name text box, and navigate back to 
the \fmonger\samples\itfonts directory.

4. The Save File as Type drop-down list should already have 
TrueType (.TTF) selected. If not, choose it from the list.

5. Click OK. FontMonger builds the font file ticker.ttf.

Repeat the process for Ticker Tape Small Caps, naming the font 
file tickersc.

You can now install all your fonts using the Windows 3.1 Fonts 
control panel, and immediately use them to finish off the annual 
report.

30 
pm

You glance at your watch, then start shaking it vigorously 
because it seems to have stopped at 5:30. After a few 
moments, you realize that it really is 5:30. You're not sure 
why, but there doesn't seem to be anything else to do 
except go home.

You nearly make it as far as the revolving doors leading 
out of the building when your assistant catches up with 
you. He says, "They want you to change something before 
you go. It won't take long...."

It's strange, your watch seems to have stopped at 5:30 after 
all.
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Chapter 4 . Converting Fonts
Outline fonts come in a number of different formats, each having 
its own mathematical system for describing the shapes of 
characters and its own system for storing them.

As well as the TrueType or PostScript fonts that you use with 
Windows, you may also have many other fonts that came with 
other software packages — fonts that you paid for. Previously you 
may have been unable to use these fonts with Windows, because 
they were not in the correct format.

This scenario is especially likely if you recently started using 
Windows for the first time, since you may have a library of fonts 
that you used with your older DOS programs.

FontMonger can convert fonts between many different formats so 
that the fonts you have may be usable within most of your 
applications.

An overview of converting fonts
When you convert a font file, you change its format. Font files are 
converted in groups called batches. The steps necessary to create 
and build a batch of fonts are:

1. Choose Convert Batch from the File menu to bring up the 
Convert Batch dialog.

2 . Create the batch of fonts you want to convert.

To add one font at a time to the batch, click Add and choose 
the font file from the Add To Batch dialog.

To add several fonts, click Find and choose a directory for 
FontMonger to scan for fonts. When the search for fonts in the 
directory is complete, add some or all of the found fonts to the 
batch.

3. Choose a new format from the New Format drop-down list.

4. Choose Convert. A dialog appears, asking for the directory in 
which you want to save the converted fonts.

5. Select an existing directory, or use the New Directory button 
to create a new directory, and choose OK.



FontMonger then converts the fonts and saves them in the 
directory you chose.

FontMonger names the files containing converted fonts by using 
the first five characters of the font's full name (not the source file 
name) followed by a number to make the names unique.

Creating a batch of fonts
When creating a batch of fonts, you can mix fonts of different 
formats in the batch. FontMonger reads and converts the fonts 
and saves them in a single destination format.

The Convert Batch dialog
The first time you choose Convert Batch from the File menu, the 
following dialog appears:

Fonts you add to the batch appear here
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When you bring up the Convert Batch dialog on a subsequent 
occasion, the Fonts in Batch list shows the fonts that you 
previously placed in the batch:

Fonts preceded by a number have 
been successfully converted

Fc nls in Batch:
1 Bolero (FontMonqerl
2 Wagner Black (FontMonger) 
Bach Oblique (FontMonger)
Bach Bold Oblique (FontMonger) 
Bach Bold (FontMonger)
Bach Roman (FontMonger) -------
Mozart Bold (FontMonger)

Convert j|
Cancel

New Format:

Add... ]  | Fjrut.. |

-Fonts with no 
number were 
not converted

Remove

a
To start a new batch, 
choose Clear Batch

To remove only selected fonts from 
the batch, choose Remove

This makes it easy to reconvert the same fonts (perhaps because 
the first conversion was interrupted, or because you also want to 
convert the fonts to another format).

The number that precedes the name of a converted font in the 
Fonts in Batch list is the same one that FontMonger used to 
construct the converted font's file name.
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Finding fonts to convert
If you don't know exactly where to find the font files on your 
system, FontMonger can scan your disk looking for files it can 
convert. You can tell FontMonger to scan the entire disk, or just 
one directory:

1. Click Find in the Convert Batch dialog. The Choose Directory 
dialog appears:
"Parent" directories of the 
current directory

2.

iGh o os #D ire cto fy

Find fonts in directory: 
c: \f tnonger\samples

Directories:

r
Drives:

T Cancel'~J]

cA
fmonger

r~l classic .

] include sub-directories

This is the current directory — 
the one that FontMonger will 
scan for fonts

-Sub-directories 
of the current 
directory

‘Choose this option to scan 
sub-directories automatically

3.

Use the Directories list box to find the directory that you want 
FontMonger to search.

When you have found the directory you want, double-click on 
it (or select the folder and press Enter) so that it has a gray 
open folder icon beside it.

Choose the Include sub-directories option if you want to 
search sub-directories of your chosen directory.

If you want to search an entire disk, choose the "root" 
directory of the disk (such as C:\) as the directory to search 
and choose the Include sub-directories option.
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4 . Choose OK to start scanning the chosen directory. When the 
scan of the files in the directory is complete, the Add To Batch 
dialog appears:

These are the fonts that 
FontMonger found

Lists the file names of 
the fonts in the list

Fonts Found:
BachiPbliqueJT!rueType)T̂l:-\;:;V'. V : 
B acH^R ojrhan (iT ru eType) ;Bojê (ifiiueTtŷ e) ’5'■“:
H an d el Ili g K t-B o Idf. r u eTiy p e j  ̂   ̂ l̂;
H a n d erL ig K ^ lta lip  (T iiu eTyp e). ' ; 
H a n d e|rEx trab o jd .(T iu eT y ^  
Hari^dei-Extiabqld I ta lic  .(T ru eT yp e), ; /
H a n d e l^ ig h t (:Tru eType) - ’
H a n 'd e llR eg u latd lta lic J[iF iu eT fy p e)^ |# K  =v.

O  List by File 

®  List by Font

List Fonts of Jype: |AII Formats" a
Choose a format if you want to 
list fonts of that format only

Lists the full font names 
of the fonts in the list

5. Select the fonts you want to add to the batch.

Alternatively, since all fonts are initially selected, you can
deselect the fonts you don't want to add to the batch.

• Click on a single font to select it and deselect all other 
fonts.

• Drag or Shift-click to select a continuous range of fonts.

• Ctrl-click on an unselected font to select it, or on a selected 
font to deselect it, without affecting other fonts.

• Ctrl-drag on unselected fonts to select (or on selected fonts 
to deselect) a continuous range of fonts without affecting 
other fonts.

6 . Choose Add Selected to add the selected fonts to your batch.

If you need to search other directories or disks, you can repeat this 
process. Each time you choose Add Selected, the selected fonts 
are added to the fonts already in the batch.

I NOTE: FontMonger will not add a font to the batch more than 
once.
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Adding a single font
If you want to add a single font to the batch and you know its file 
name, choose Add in the Convert Batch dialog. The Add To Batch 
dialog appears:
Choose the file that contains Choose OK to add the
the font you want selected font to the batch

This part of the 
dialog is the same 

-  as the standard 
Windows 3.1 
Open File dialog

Notice that the List Files of Type drop-down list can help you 
locate files faster. By choosing one of the items from this list, you 
restrict the File Name list to files having the corresponding 
extension.

The Fonts list remains empty when you select a file that is not a 
font file, or that does not contain any fonts.

Converting a batch of fonts
After you've constructed your batch of fonts by using Clear Batch, 
Add, Find and Remove, converting them is a simple process:

1. Drop down the New Format list to display the formats to 
which you can convert your fonts.

2. Choose a format from the list. All fonts in the batch will be 
converted to this format.

If you choose FontMonger as the destination format, the fonts 
in the batch are not converted to another font format. Instead,

If the selected file contains more than 
one font, select the font you want
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they are simply saved as FontMonger font document files. If 
you plan to make changes to a number of font files, batch 
converting them in advance to document files will speed the 
process of opening them to make changes.

3. Choose Convert to bring up the Choose Directory dialog:

Put converted fonts in directory: 
c: \f monger\samples\classic

Directories: Drives:

L . . «  J
| .Cancel f I

(S' c :\
£> fmonger 
£> samples 

classic

i® « =  i i  i

| New Directory J

4. If you want to create a new directory to hold the converted 
files, choose New Directory and type a new directory name.

Creating a new directory is often a good idea because it helps 
keep the converted files separate from existing files, making it 
easier to find them when you go to install the new fonts.

If you want to use an existing directory, "navigate" through 
the Directories list to the desired location.

5. Choose OK.

FontMonger does the rest. As the fonts are converted and saved 
you will see a progress indicator that tells you which font 
FontMonger is currently reading or saving — and the number of 
fonts left to convert in the batch.

Supported file formats
FontMonger can convert between various font formats used on 
your PC. It can also convert to and from Macintosh and NeXT file 
formats.
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Font formats FontMonger can read
• FontMonger document files

— .FRF or .FRT extensions

• Windows TrueType font files
— .TTF extension

• Macintosh TrueType font files
— System 7 TrueType files, or suitcases containing TrueType fonts

• PC PostScript Type 1 font files from any vendor
— .PFB extension, with optional .PFM and/or .AFM files

• CorelDraw font files
— .WFN extension

• LaserMaster font files from LaserMaster LX6 Professional Controllers 
and Plain Paper Typesetters
— .LXO extension

• Macintosh PostScript Type 1 font files from any vendor
— downloadable font file, with optional suitcase file containing 

screen fonts and/or .AFM file

• NeXT PostScript Type 1 font files
— .NXT extension, with optional .AFM file

• PostScript Type 3 font files in major formats, including those 
produced by FontMonger for Macintosh, FontStudio and 
Fontographer, as well as fonts from Bitstream, Monotype, Casady & 
Green, etc
— PC: .PFA extension, with optional .PFM and/or .AFM files
— Bitstream Fontware: .PSO extension
— Mac: downloadable font file, with optional suitcase file

• Nimbus Q from any vendor, including URW, SoftType and 
SuperPrint fonts
— .FNT extension

• Intellifont FAIS
— .FI extension, with associated .FF files
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Font formats FontMonger can write
• FontMonger document files

— .FRF or .FRT extensions

• Windows TrueType font files
— .TTF

• Mac TrueType font files
— System 7 TrueType files

• PC PostScript Type 1 font files
— .PFB, .PFM and .AFM files, plus .INF files for use with Adobe 

Font Foundry

• Macintosh PostScript Type 1 font files
— downloadable font file, plus suitcase file containing screen fonts

• NeXT PostScript Type 1 font files
— .NXT and .AFM files

• PostScript Type 3 font files
— PC: .PFA, .PFM and .AFM files
— Mac: downloadable font file, with suitcase file

• Nimbus Q font files
— .FNT
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Chapter 5. Managing Font Files
This chapter discusses the various font files that FontMonger 
converts from or builds.

You will find this information useful when you install or remove 
font files, and when you convert fonts to or from a Macintosh or 
NeXT computer.

Windows TrueType fonts
When you build a Windows TrueType font, FontMonger 
produces a single file with extension TTF.

You install a Windows TrueType font with the Windows 3.1 Fonts 
control panel. Refer to your Windows documentation if you need 
more information about using the Fonts control panel.

To install a TrueType font, the Fonts control panel:

1 . Creates an additional file, with the same name as your font file 
but with extension FOT. This file is used internally by 
Windows and is located in your Windows system directory.

2 . Copies your font file into the Windows system directory, 
unless you uncheck that option in the font installation dialog.

If you let the control panel copy your file, then you can delete 
your file or move it to another directory. If no copy is made, 
the file is used directly by Windows, so you should not move 
or delete it unless you uninstall it first.

3. Makes the font available to all applications.

If you build an updated font file with FontMonger, you should 
use the Fonts control panel to remove the older version before 
installing the updated font.

To remove an installed TrueType font, the Fonts control panel:

1 . Makes the font unavailable to all applications.

2. Deletes the file with extension FOT.

3. Deletes the file with extension TTF, if you check the 
appropriate check box.



Corel
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PostScript Type 1 fonts
When you build a PC PostScript Type 1 font, FontMonger 
produces four files, with extensions PFB, PFM, AFM and INF.

For most purposes, you need only the PFB and PFM files. 
However, if you intend to use Adobe Font Foundry to build fonts 
for DOS applications, you'll also need the AFM and INF files.

Installing and removing fonts with ATM
When you use ATM to install a font, you need only the PFB and 
PFM files. ATM copies the PFB file to the PostScript fonts 
directory (normally \psfonts), and copies the PFM file to the pfm 
sub-directory.

If you need to remove an installed font, first use ATM to remove 
the font from its internal font list, then delete the files that ATM 
copied to \psfonts and \psfonts\pfm.

Using Adobe Font Foundry
If you have ever purchased any Adobe fonts, your font package 
included a copy of the Adobe Font Foundry utility, which you can 
use to create fonts for non-Windows applications such as Word 
for DOS and WordPerfect for DOS.

Before starting Font Foundry, move the PFB file into \psfonts, 
move the PFM file into \psfonts\pfm, move the AFM file into 
\psfonts\afm and move the INF file into \psfonts\fontinfo. 
(Substitute the name of your PostScript font directory, if it has a 
different name.)

You may also need to rename your files. Font Foundry requires 
the use of Adobe's font file naming convention — the PFB, PFM, 
AFM and INF file names must be exactly five characters in length. 
Font Foundry adds three more characters to the names of the files 
it produces.

Also, the five-character name appears within the INF file. If you 
rename your font files, you must edit the PCFileNamePrefix line 
in the INF file so that the names match. The INF file is simply a 
text file, so you can edit it with a text editor like Notepad.

Consult the Adobe font installation guide for instructions on using 
the Font Foundry program.
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Other uses for PostScript fonts
A number of other font management programs can make use of 
PostScript Type 1 fonts, including Bitstream Facelift and ZSoft 
SoftType.

Consult the documentation that came with your program for 
instructions on using PostScript fonts.

Nimbus Q Fonts
You can use Nimbus Q font files built by FontMonger in 
applications like ZSoft SoftType and GeoWorks Ensemble.

Installing fonts in SoftType
Follow the instructions in your SoftType manual for installing 
typefaces.

Installing fonts in GeoWorks Ensemble
Follow the instructions in your GeoWorks Ensemble 
documentation for installing fonts.

Note that GeoWorks Ensemble converts Nimbus Q fonts to a 
different format when you install them. Although the converted 
fonts have the same name and extension, they are no longer in 
Nimbus Q format.

NeXT fonts
FontMonger can convert PostScript Type 1 fonts to and from the 
format required by NeXT computers.

Transferring fonts from NeXT
On the NeXT computer, copy the outline font file onto a DOS disk. 
You can also copy the matching .afm file if you want to retain the 
font's kerning pairs.

On your PC, change the outline font file's extension to NXT before 
attempting to convert or open the file with FontMonger.

I NOTE: FontMonger will not recognize a NeXT font file unless it 
has extension NXT.
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Transferring fonts to NeXT
After you build a font in NeXT PostScript Type 1 format, copy the 
PFB and AFM files onto a DOS disk.

On the NeXT computer, you will need to change the extensions of 
the files on the DOS disk before you can install them.

Consult your NeXT documentation for information on the correct 
extensions to use, and on the procedure for installing the fonts.

Macintosh fonts
FontMonger can convert and build Macintosh TrueType and 
PostScript fonts (in either Type 1 or Type 3 format).

Using Apple File Exchange
If you have access to a Macintosh that has a 1.44MB floppy disk 
drive, the simplest way to transfer files is via Apple File Exchange 
and the FontMonger File Translator module supplied with 
FontMonger.

The FontMonger File Translator module automatically detects the 
various file formats that FontMonger supports, and performs an 
appropriate conversion — from PC to Mac format or from Mac to 
PC format.

The File Translator for Macintosh floppy disk in your FontMonger 
package contains a Read Me file that explains how to install and 
use Apple File Exchange translators.

I NOTE: This is a Macintosh disk. You won't be able to read it on 
your PC without special hardware or software.

Other methods of transferring files
There are numerous other methods of transferring files between a 
Macintosh and your PC, but to use them successfully you'll need 
to know the formats of the files you transfer.

Text files (AFM files and NXT files) need to have line-feed 
characters removed when they are transferred to the Macintosh, 
or added when they are transferred from the Macintosh.

Macintosh resource files (suitcase files, System 7 TrueType fonts 
and downloadable font files) must be converted to MacBinary
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format when they are transferred to your PC, and converted from 
MacBinary format when they are transferred from your PC.

Many Macintosh communications programs can convert a file to 
or from MacBinary format during transmission, so you can often 
transfer files between computers by connecting them with a serial 
communications cable.

There are also hardware and software products available that 
allow you to read Macintosh disks on your PC. Before trying to 
use one of these products, check that it can perform the file format 
conversions that FontMonger needs.

You must ensure that all files that you transfer from a Macintosh 
to your PC must have extension MRF.

I NOTE: FontMonger will not recognize a Macintosh font file unless 
it has extension MRF.

Using Macintosh files
For a TrueType font, transfer the System 7 TrueType file or a 
suitcase file containing the font.

For a PostScript Type 1 or Type 3 font, transfer the downloadable 
font file. If you have a matching suitcase file (containing screen 
fonts), you should transfer that as well, since it contains additional 
information about the font that is not present in the downloadable 
font file. The screen fonts themselves are not used by FontMonger.

If you have no suitcase file but you have an AFM file, transfer the 
AIM  file instead.

If you have neither a suitcase nor an AFM file, then FontMonger 
will accept the downloadable font file by itself.

Building files for Macintosh
FontMonger builds Macintosh TrueType fonts as System 7 
TrueType font files, but does not produce any bitmap fonts.

For PostScript fonts, FontMonger builds three files: one MRF file 
that will become the downloadable font file when converted, a 
second MRF file that will become a suitcase file, and an AFM file.

The suitcase file for a PostScript font contains a single 13 point 
screen (bitmap) font.
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Chapter 6. Keyboard Windows
When you open a font document file, FontMonger displays the 
font in a keyboard window, which appears within FontMonger's 
main window.

Keyboard windows can be moved, resized, minimized and 
maximized within the main window using the standard Windows 
techniques. Refer to your Windows documentation if you need 
more information on any of these operations.

Opening a font
The procedure for opening a font is the same no matter whether 
you want to open a FontMonger document file (containing a font 
that you previously saved in FontMonger) or a font file (in any of 
the formats that FontMonger can convert):

1. Choose Open from the File menu. The Open Font dialog 
appears:

Choose the file that contains 
the font you want to open

This part of the 
dialog is the same 

-  as the standard 
Windows 3.1 
Open File dialog

The List Files of Type drop-down list can help you locate files 
quickly. By choosing one of the items from this list, you 
restrict the File Name list to files having the corresponding 
extension.

FHe Name:
mozar2.pfb c:\fmonger\samples\classic

mozar2.afm I &  c:\
mozar2.inf 0  fmonger

mozar2.pfra 17̂  samples
wagnel.afm classic
wagnel .inf M:
wagnel .pfb Jccx
waqnel.pfm I

List Files of Jype: 
|All Files ['.*)

Drives:

a

If the selected file contains more than one 
font, select the font you want to open



2 . Select a file in the File Name list. The Fonts list at the bottom 
of the dialog shows you the names of all fonts contained in the 
file.

NOTE: FontMonger document files and most font files contain 
only a single font. However, a few  font file formats permit several 
fonts per file. In that case, you indicate the font you want to open 
by selecting it in the Fonts list.

The Fonts list remains empty when you select a file that is not 
a document or font file, or that does not contain any fonts.

3. Choose OK.

As a shortcut, you can simply double-click on the file or font 
you want to open.

Since opening a font takes a few seconds — especially if you 
choose a font file that needs to be converted — FontMonger 
displays a progress indicator while the font is being opened.

At the completion of the process, FontMonger displays a keyboard 
window showing you the characters in the font and the keys they 
are assigned to:

If you open a FontMonger font document file, 
the name of the file appears in the title bar

If you open a font file, an untitled 
keyboard window is displayed

| |, . -’- - a - . ill
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Opening multiple fonts
You can open and work with multiple fonts — simply open each 
of them in turn. Each font has its own keyboard window, and you 
can use the normal Windows operations to move, size and 
activate them. Any keyboard window can also be minimized to an 
icon within FontMonger's main window.

With multiple keyboard windows open you can cut, copy and 
paste characters from one font to another.

Just how many keyboard windows you can open at one time 
depends on how much memory your system has available.

Saving a font
After you have finished making changes to a font, you should 
save it as a font document file on disk, so that you can open the 
font again later without having to reconvert it from a font file or 
make the changes again. To save a font:

1. Choose Save from the File menu.

If the keyboard window is untitled, the Save As dialog 
appears, allowing you to choose a name and directory location 
for the new FontMonger document file that will be created:

Type the name you want 
to use for the FontMonger 
document file

Choose the drive and 
directory where you 
want to save the file

File Name:

bachblO.Mf
bachbll.ttf
bachoSUtf
bachr12.tif
bolerl.Uf
hande2.Uf
hande3.ttf
hande4.ttf

& c:̂
^  fmongei 
1?=i samples

Directories:
c:\fmonger\samples ^classic

*
Save File as Type: Drives:Drives:
| FontMonger (.FRF) | jfc| | B  c: a
Choose either the normal or template 
FontMonger document type

Otherwise, the font is saved in the same document file from 
which it was opened, replacing the previous version of the
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font. In this case, no dialog appears. If you want to preserve 
the old version, you can choose Save As from the File menu 
instead of Save, thus forcing FontMonger to save the font in a 
new document file.

2. If the Save As dialog appears, choose a document type from 
the Save File as Type drop-down list.

When you save a new font or use Save As to save a font into a 
new document file, you have the option of creating a normal 
FontMonger document file (with extension FRF) or a template 
file (with extension FRT).

A template file is just like a normal document file, except that 
when you open a template file FontMonger automatically 
makes a copy of the font and displays it in an untitled 
keyboard window. Thus, the template file is protected against 
inadvertent changes.

3. Choose OK. FontMonger displays a progress indicator while it 
saves the font displayed in the keyboard window.

You cannot install a FontMonger document file. Instead, you must
use Build Font from the File menu to create a font file in
TrueType, PostScript or Nimbus Q format. See "Building font
files" later in this chapter.

Closing keyboard windows
You can close a FontMonger keyboard window in several ways.
The method you choose is a matter of personal preference:

• Double-click on the system menu icon in the top left comer of 
the keyboard window.

• Pull down the keyboard window's system menu with the 
mouse or by typing Alt+hyphen, then choose Close.

• Type Ctrl+F4.

• Choose Close from FontMonger's File menu.

• Type Ctrl+W.

In the last three cases, if there is more than one window open,
FontMonger closes the active window.
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Before FontMonger closes a keyboard window, it checks whether 
you have made any changes to the font displayed in the window. 
If you have, FontMonger asks you whether you want to save or 
discard the changes:

Save the changes and Discard the changes but 
close the window still close the window

^ 7 ^  Save FontMonger docuim nt 'MOZB.FRF' before closing?

|^.‘iSw e] 1 11 DertSaye

Reverting to the saved version of a font
Changes you make to a font document are kept in memory or in a 
temporary file until you save the font — the previous version of 
the font is untouched.

If you make changes that you do not want to keep, you can return 
to the previous version of the font by choosing Revert to Saved 
from the File menu.

After confirming that you want to revert, FontMonger will reread 
the previous version of the font, discarding any changes you have 
made since the font was last saved.

Keyboard layout
A keyboard window is an on-screen representation of the 
keyboard attached to your computer.

Since FontMonger cannot detect the exact size, shape and position 
of the keys on your keyboard, the keyboard window layout may 
differ slightly from your keyboard.
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However, FontMonger can determine which character is produced 
when you press each key on your keyboard. The keyboard 
window shows you these characters on the appropriate keycaps.

Keycaps show the character in the Keys that can never have an associated
font that is associated with each key character are shown completely gray

*1 .heJ \'r ■-j.tf-

~ JiilwSSrtHy  LlL _>_! !
...i f i l  *1 *0  U M S I  111k IJL -j

: •swft f xfl x {  11 y f b|] 1*| nif ..; ..J
Ctfl j] Alt |  ; - ' _  ̂ t -• J , A»........I

, Font;MozartBoId

■ JL ! r F
If the font has no character for a key, the keycap shows 
a grayed character from the System font instead

Modifier keys
Clearly, there are many more characters in a font than there are 
character keys on your keyboard. To access the rest of the 
characters, you have to hold down the Shift, Ctrl or Alt key (or 
some combination of them) while you press a character key. These 
three keys are called modifier keys.

If you click on one of the keycaps labeled Shift, Ctrl or Alt in the 
keyboard window, FontMonger changes the display to show you 
the characters your keyboard produces when you hold down that 
modifier key.

NOTE: FontMonger also recognizes Caps Lock as a modifier key, 
because it is possible — with a few  unusual keyboard layouts — for  
the Caps Lock key to produce characters that cannot be typed with 
Shift, Ctrl and Alt.

You can click on more than one modifier to see the effect of 
holding down a combination of modifier keys.
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The Ctrl and Alt keycaps are highlighted, indicating that 
the keyboard window is displaying the characters you get 
when you type with the Ctrl and Alt keys held down

Click on the modifiers a second time to return them to their 
previous state.

On most keyboards, only a few combinations of modifier keys are 
actually useful. For Windows, a typical keyboard arrangement is:

no modifiers lowercase letters, numbers and punctuation

Shift uppercase letters and special characters

Ctrl+Alt special characters and lowercase accented letters

Shift+Ctrl+Alt special characters and uppercase accented letters

Display options for keyboard windows
Under Windows 3.1, a font may have up to 256 characters 
(although most fonts have only around 2 0 0  characters).

Depending on the keyboard configuration you have chosen, not 
all of these characters may be accessible from the keyboard.

In the normal keyboard layout view, FontMonger allows you to 
work only with characters that are accessible from the keyboard, 
since there's no way to show whether non-keyboardable 
characters are selected.
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If you need to work with the entire character set, you can choose 
Character Chart from the Options menu to get a complete view of 
the font:

A-]|
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The character chart is a grid of character positions, made up of 16 
rows and 16 columns. The first 10 rows and columns are labeled 
0-9, while the last six are labeled A-F.

At each grid position, FontMonger shows you a character from the 
font, or a grayed character if there is nothing assigned to that 
position.

Character numbers
In any application, Windows allows you to enter characters that 
are not directly keyboardable by typing a number on the numeric 
keypad while the Alt key is held down.

In the character chart view of a keyboard window, FontMonger 
shows you these numbers just below their corresponding 
character positions.

Using the character chart view
Although the character chart is a different view of the font, you 
use it in exactly the same way as a keyboard layout view:

• Click or drag to select characters with your mouse.

• Type keys on your (real) keyboard to select the corresponding 
keycaps in the window. Note that you can also select keycaps 
by typing Alt+numeric keypad combinations.
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• Use cut, copy and paste to rearrange the font.

Any function you can perform in the keyboard layout view can 
also be performed in the character chart view.

Choose Character Chart from the Options menu again to return 
to the normal view.

Selecting characters
Within a keyboard window, you choose the characters you want 
to work with by selecting their keycaps.

The exact appearance of keycaps depends on what kind of screen 
you are using, but generally selected keycaps show a light-colored 
character on a darker background, while unselected keycaps show 
a dark-colored character on a light background:

Unselected keycap Selected keycap

If you have a color screen that does not show enough contrast 
between the light and dark colors, you can choose Black and 
White from the Window menu to force FontMonger to draw the 
keycaps in black and white only.

Selecting by clicking with the mouse
You can select a single character in a keyboard window by simply 
clicking on it with the mouse.

Hold down the Ctrl or Shift key (on your real keyboard) while 
clicking to retain any previous selection. If you do not hold down 
one of these keys, selecting an unselected keycap deselects all 
others.

Selecting by dragging with the mouse
You can select multiple characters by dragging over them with 
your mouse. All characters that the mouse pointer passes over 
while the mouse button is pressed will be selected.

Hold down the Ctrl or Shift key while dragging to retain a 
previous selection in addition to the characters you drag over.
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Selecting characters by typing
You can also type characters on your keyboard to select them in 
the keyboard window. While typing, hold down the Shift, Ctrl or 
Alt keys as necessary to get the characters you want.

Unlike selection by clicking, typing a character does not deselect 
previously selected characters. If you want to deselect the 
previous selection, press Esc before typing the character.

Typing the same character a second time deselects it.

Selecting all characters
To select all characters accessible from the keyboard, choose 
Select All from the Edit menu.

Selecting character ranges
As well as Select All, the Edit menu contains items that select 
several useful ranges of characters:

Select 0-9 selects only number keys.

Select a-z selects only unaccented lowercase letters.

Select A-Z selects only unaccented uppercase letters.

To select one of these character ranges, simply choose it from the 
menu.

As usual, you can use the Ctrl or Shift key to retain any 
previously selected characters — hold down Ctrl or Shift while 
choosing from the menu.

For example, if you wanted to select all uppercase and lowercase 
letters you would:

1 . Choose Select a-z from the Edit menu to select lowercase 
letters.

2 . Press and hold the Ctrl key.

3. With your mouse, choose Also Select A-Z from the Edit 
menu.

Note that the menu item has changed from Select A-Z to Also 
Select A-Z.

4. Release the Ctrl key. Both ranges are now selected.
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NOTE: You can also define your own selection ranges and have 
them appear on the Edit menu. See "Customizing Selection 
Ranges" later in this chapter.

Deselecting characters
Deselecting all selected characters
You can deselect all selected characters in a keyboard window by:

• clicking in any background area of the keyboard window, 
away from any keycap, or

• pressing Esc.

Deselecting a single character
You can deselect a single character by holding down the Ctrl or 
Shift key while you click on the appropriate keycap.

Or, you can type a selected character from your real keyboard to 
deselect it.

Deselecting multiple characters
You can deselect multiple characters by holding down the Ctrl or 
Shift key while dragging over the characters you want to deselect, 
starting from a selected character.

Miniature keyboards
You can only see the keycaps for one combination of modifier 
keys (Shift, Ctrl, Alt or Caps Lock) at one time, but you can select 
characters from different combinations. For example, you can 
select A-Z (Shift modifier) as well as a-z (no modifier).
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FontMonger makes the entire selection visible by displaying 
miniature keyboards at the bottom of the keyboard window:

i£?t  ̂ \ |/£

■ W - : ! -  1 . : .
_

 I S i l i i l i l i a p i l ip

- Miniature keyboards

There is room for four miniature keyboards, one each for the 
following modifier combinations:

no modifiers Shift Ctrl+Alt Shift+Ctrl+Alt

Each of these four miniature keyboards appears in a fixed 
position, but if there are no selected keycaps for a modifier 
combination, the miniature keyboard is not displayed:

Font Bach Roman

Only the capital letters are selected, so the miniature keyboards 
for unmodified keys, Ctrl+Alt keys and Shift+Ctrl+Alt keys 
are not displayed

Thus, the miniature keyboards give you a quick visual reminder 
of which characters will be affected by cut, paste or delete 
operations, or by alterations applied from the Alterations menu.

FontMonger User Guide



Using FontMonger's built-in alterations
Built into FontMonger are four commonly used alterations. These 
alterations are included in the Alterations menu along with a 
Normal item that removes alterations and returns characters to 
their unaltered state:

Small Caps 
Slant 
Superior 
Inferior
Customize Alteration...

Alter Character(s)
Previous Character Ctrl+Left
Next Character Ctrl+Right

To apply any of these alterations, select the characters you want to 
alter and choose the alteration from the Alterations menu.

Each time you apply a built-in alteration, it completely replaces 
any previous alterations that have been made to the selected 
characters. This means, for example, that you cannot make slanted 
small caps using the built-in alterations — you can apply the 
Small Caps alteration or the Slant alteration, but not both 
simultaneously.

If you need the equivalent effect of applying two built-in or 
custom alterations, you must create a custom alteration using the 
Alter Character window that combines them into one custom 
alteration. See Chapter 7 for an explanation of creating custom 
alterations.

Customizing fonts
The ways you can use FontMonger to customize fonts include:

• Rearranging characters by moving them to new keyboard 
positions.

• Adding new characters to a keyboard. The new characters 
come from the font's own character set, from other fonts, or 
from imported graphics.

• Removing characters from your keyboard.

• Creating new character outlines within FontMonger.
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Rearranging characters with Cut, Copy and Paste
If you want to move characters to new key positions, FontMonger
allows you to do so easily using Cut, Copy and Paste from the
Edit menu:

• Cut copies the selected characters onto the clipboard, then 
removes them permanently from the font.

• Copy places the selected characters onto the clipboard, 
without changing the font.

• Paste replaces the characters on selected keycaps with the 
characters on the clipboard.

Combining fonts with Cut, Copy and Paste
You can also customize fonts by combining parts of other fonts.
These fonts are sometimes called merged fonts.

To copy characters from one font to another:

1. Open both the "source" font and the "destination" font, so that 
both keyboard windows are open simultaneously.

2 . Select the characters you want to copy from the source font.
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3. Choose Copy from the Edit menu.

4. Activate the keyboard window of the destination font, making
sure that there are no selected keycaps in the window.
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5. Choose Paste from the Edit menu. The characters are copied to 
the same key positions in the destination font that they 
occupied in the source font.

To copy the characters to different key positions, select the desired 
keycaps in the destination font before you paste the characters 
into it.

Deleting characters from a font
Choosing Delete from the Edit menu or pressing Delete on your 
keyboard permanently removes the selected characters from a 
font.

Removing characters from the keyboard
If you want to remove selected characters from their keyboard 
positions, without removing them permanently from the font, 
choose Remove Character(s) from the Edit menu.

Characters removed in this way still exist within the font, and can 
be reassigned to new keyboard positions, if necessary, with the 
Choose Character dialog.

Assigning characters with Choose Character
Fonts usually contain many more symbols than appear on your 
keyboard — typeface designers often create many related symbols 
that are unassigned in your font. You can assign these extra
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characters to unused keyboard positions, or replace existing 
keyboard assignments.

To assign a character in your font to a keyboard position:

1. Select the keycap to which you want the character assigned.

2. Choose Choose Character from the Edit menu. The Choose 
Character dialog appears:

The highlighted character is the one 
associated with the selected keycap

3. Select a new character from the character list. The characters 
are listed in alphabetical order by their names.

4. Choose OK.

Or, simply double-click on the newly chosen character in the 
character list.

FontMonger assigns the chosen character to the selected key and 
displays it on the keycap.

Creating a new font
Sometimes you might want to create a completely new font rather 
than modifying an existing one. For instance, you might want to 
create a font that contains just your company logo.
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To create a new font, choose New from the File menu. An untitled 
keyboard window appears:

The font initially contains no characters, so the keycaps all show 
grayed characters.

You can add characters to a new font by pasting them from 
another font, or by importing graphics files.

Importing graphics
Importing graphics into FontMonger is a straightforward process:

1. In a keyboard window, select the key to which you want to 
assign the imported graphic.

2. Choose Import Character from the File menu. The Import 
dialog appears:
Select the file you Choose the drive and directory
want to import that contains the file
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3. Select the name of the file containing the graphic and choose 
OK.

You should exercise some caution when importing complex 
graphics into a font. If you install a font with extremely complex 
characters, the font may not display or print correctly.

NOTE: FontMonger attempts to detect graphics that are likely to 
be too complex and warns you o f this fact. I f  you wish, you may 
ignore the warning, but you should test your font thoroughly to 
make sure it works on both your screen and your printer.

Graphics formats that FontMonger can import
The graphic formats which can be imported into FontMonger are:

• Files produced by Adobe Illustrator (Windows or Macintosh). 
CorelDraw, Micrografx Designer and Arts & Letters can also 
produce files in Adobe Illustrator format.

• Encapsulated PostScript files from applications such as Adobe 
Illustrator, Micrografx Designer, Aldus FreeHand or 
CorelDraw.

Due to the wide variety of application-specific EPS formats, not all 
EPS files can be imported by FontMonger. If you have files 
produced by an application not listed above, you will need to 
experiment to find out if they can be imported.

Preparing artwork for importing
When drawing artwork for use in a font, you need to be aware of 
the unique limitations that apply to character outlines:

• Avoid over-complexity.

Font-rendering software — the software that draws characters 
on your screen (such as Windows 3.1 for TrueType fonts) or 
prints them on your printer (such as a PostScript language 
interpreter) — has built-in limitations on the complexity of any 
individual character.

• Don't use strokes and fills.

Colors, line thicknesses and fill patterns are all inappropriate 
for characters. All that matters is the shape of the outlines you 
draw.
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If you draw: You 7/ get this:

Font rendering software does not use explicit
strokes and fills. Instead, it simply fills the interior of every
shape with black.

Use only closed shapes.

An outline is closed if its end joins to its beginning. Characters 
with unconnected ends will not display or print properly.
To get:   Draw this:   Not this:

If you want to draw what looks like a line — a
long dash, for example — you must actually draw a long,
narrow rectangle.
To get: Draw this: Not this:

□

• Don't let outlines cross themselves or each 
other.

Characters like X that give the impression of being made up of 
two crossing strokes are actually made up of four shorter 
strokes, spliced at the center of the character.
To get: Draw this: Not this:x
If you want a hole inside a character, like the
center of an O, draw two shapes — the shape of the character
and the shape of the hole — and put one inside the other.

When one shape encloses another, font-rendering software 
fills only the area between the shapes.
To get:

O

Draw this:
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Setting font information
As well as descriptions of the characters it contains, a font has 
additional information that describes the font as a whole.

Font families
Often, related fonts are grouped into font families. Usually, all fonts 
in a family have the same basic design, with only a limited range 
of well-established variations.

The most common kind of font family contains four fonts (often 
called faces in this context):

Regular (also called plain or normal or roman)
Bold (thicker character strokes)
Italic (slanted, cursive character forms)
Bold Italic (combination of the bold and italic styles)

Fonts in the same family all share the same basic family name 
(such as Times). They are distinguished by different style names 
(also called weight names or subfamily names).

You can view or change these names for a font in FontMonger by 
choosing Set Font Information from the Options menu to display 
the Set Font Information dialog:

Family Name:

Font Style/Weight Name:
Regular

Stroke Weight:

Font Width:

Family Relationship: 

Family Metrics: 

Ascent: |P |

Descent: |0 |

| Normal

Plain member

Line Gap: [o~

Font Classification: 
IEI Sans-serif 
□  Decorative

Family and style names usually consist of one or more words, 
with the first letter of each word capitalized. Words may be 
separated by spaces or hyphens. (You will also encounter many 
fonts where the words aren't separated from each other at all.)
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Stylistic variations
There are three main stylistic variations that account for the
differences between members of a font family:

• Italics. In many families, italic faces are almost a separate 
design. However, since the italic faces are designed especially 
to match the upright faces, they are treated as part of the 
family.

• Stroke weight. The upright strokes of characters may vary in 
thickness. Fonts with thinner strokes than normal are called 
light, while fonts with thicker strokes are called bold.

Many gradations of thickness are commonly used. The Stroke 
Weight drop-down list in the Set Font Information dialog 
allows you to specify the most common ones.

• Font width. The overall proportions of the characters in a font 
can be stretched or squeezed horizontally. These variations are 
called expanded (or extended) and compressed (or condensed), 
respectively.

Again, many gradations are possible, and the Font Width 
drop-down list in the Set Font Information dialog provides a 
choice of the most popular ones.

NOTE: You do not change a font's appearance by choosing 
different entries from either o f these drop-down lists. Your choices 
are simply for  information, and may be used by Windows or other 
font-management software to determine the intended characteristics 
o f the font.

Family relationship
Certain members of a font family have a privileged status:

• The plain font is the one you get if you simply select some text 
in an application and choose the family name from the 
application's font list.

Usually, the plain font is the one whose stroke weight is 
regular and whose font width is normal.

• The bold, italic and bold italic members are the ones that you get 
if you use an application that allows you to apply bold and 
italic formatting without explicitly changing fonts.
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You should always make an appropriate choice from the Family 
Relationship drop-down list in the Set Font Information dialog. If 
your font is the only member of its family, or if it is the central 
family member, choose Plain member from the list.

If the font is a bold, italic or bold italic family member, choose the 
corresponding list entry.

Otherwise choose Other family member from the list.

Family metrics
The Ascent, Descent and Line Gap text boxes determine the 
vertical spacing of a font when it is used for multi-line text.

If you set all three values to zero, FontMonger determines the 
spacing automatically, based on the heights of the characters 
within your font.

If you want to ensure that all members of a font family produce 
the same vertical spacing, regardless of any small variations in 
character heights among different family members, you must 
specify the same ascent, descent and line gap values for each 
family member.

The ascent is the amount of vertical space allocated for the font 
above the baseline on which most characters sit. Generally, you 
would use the height of the capital letters or the tall lowercase 
letters such as b, d or k. (The top portions of such lowercase letters 
are called ascenders.)

The descent is the amount of vertical space allocated for the font 
below the character baseline. Generally, this is the depth of 
lowercase letters like p, q and y. (The bottom portions of these 
letters are called descenders.)

The line gap is an additional clearance that is added between lines 
of text.

All three values are specified in Vioooths of the font's point size. A 
typical font ascent would be approximately 660, and a typical 
descent would be approximately 250. The line gap is often zero or 
a small number like 1 0 0 .
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Font classification
The two Font Classification check boxes are used to inform 
Windows of further basic information about your font.

If your font has no serifs (short cross-strokes at the ends of the 
main strokes), check the Sans-serif check box.

If your font consists mainly of non-alphabetic symbols, such as 
music notation, map symbols or mathematical symbols, check the 
Decorative check box.

Setting font protection
Fonts may contain information designed to protect the rights of 
the font designer.

FontMonger allows you to view this information, and — in the 
case of fonts that you created — to change it.

Choose Set Font Protection from the Options menu to display the 
Set Font Protection dialog:

Copyright Notice: 1 OK j
| Cancel - J

<§> No protection
O Read-only encapsulation allowed
O No encapsulation allowed

The Copyright Notice text box contains the copyright text that 
was embedded in a font you converted. All commercial fonts have 
a copyright notice to identify the font's owner.

The encapsulation options currently apply to Windows TrueType 
fonts only, and control whether the font may be embedded in a 
document you transfer to another computer.

Choose No protection to allow unlimited distribution of the font.

Choose Read-only encapsulation allowed if the font may be 
embedded into a document and used to view the document on 
another computer. The font may not be used on that other 
computer for any purpose except viewing the document.
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Choose No encapsulation allowed if the font may not be 
embedded in documents. This is the highest level of protection.

Building font files
Any time you create a new FontMonger document file, or change 
an existing font document, you must build a font file if you want 
to install the new or revised font in your system.

The font file you build is in the format that your system needs — 
such as TrueType for Windows 3.1, PostScript Type 1 for ATM, 
and Nimbus Q for SoftType or GeoWorks.

You can also build font files for Macintosh or NeXT systems.

To build a font file:

1. Open a keyboard window for the font, if necessary.

A convenient time to build the font file is right after you save 
the FontMonger document file.

2. Choose Build Font from the File menu. The Build Font dialog 
appears:

Type the name you want Choose a drive and directory
for the font file to hold the new file

Choose a font file format

NOTE: I f  the Set Font Information dialog appears instead o f the 
Build Font dialog, your font does not have a name. Fill in the 
appropriate font information, including a name in the Fam ily  
N am e text box, then click OK. The Build Font dialog will then 
appear. See "Setting font information" earlier in this chapter for  an 
explanation o f the Set Font Information dialog.
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3. Enter a name for the font file, and choose a directory location 
to place the file into.

Don't enter an extension as part of the file name, since 
FontMonger supplies the correct extension automatically.

4. Choose the font format from the Save File as Type drop-down 
list.

5. Choose OK. FontMonger then builds the font file.

Some font formats require more than one file to describe the font. 
FontMonger builds any necessary auxiliary files after building the 
main file. The auxiliary files have the same name as the main file, 
but a different extension.

Once the font file and its auxiliary files are built, the font is ready 
for installation. Refer to Chapter 5 for information on installing 
font files of various formats.

Printing a font layout
FontMonger allows you to print the contents of a font as a 
keyboard layout chart that you can use as a reference guide.

To print a font layout:

1 . Make sure the keyboard window shows the keyboard layout 
view. If the character chart view is displayed, choose 
Keyboard Layout from the Options menu.

2. Choose Print Setup from the File menu, and set the printing 
parameters that you want.

On standard 8 V2 by 11 inch paper, you'll make better use of 
the paper if you choose landscape orientation — and you'll 
also get a larger chart.

3. Choose Print from the File menu, then choose OK.

FontMonger prints keyboard layouts in two parts. The first part is 
a representation of the keyboard, with each key containing up to 
four characters arranged like this:
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unmodified

Shift+Ctrl+Alt

Ctrl+Alt

Below the keyboard layout
is a list of all the other characters in the font that can be accessed 
from the keyboard, along with the combination of keys you need 
to press to get each character. If necessary, this list continues onto 
a second page.

Printing a character chart
If the keyboard window is showing the character chart view when 
you choose Print, FontMonger prints the character chart instead of 
a keyboard layout.

Exporting graphics
FontMonger can export characters from any font as graphic 
images in Adobe Illustrator, EPS or Windows Metafile formats.

Files containing exported characters can then be opened by 
graphics programs and used as design elements.

If you wish, you can export characters from a font, edit them in a 
graphics program, then import them back into the font. However, 
it is usually easier to edit the characters within FontMonger itself, 
using FontMonger's built-in drawing tools as described in 
Chapter 8.

To export one or more characters from a font:

1. Open a keyboard window for the font containing the 
characters to be exported.

2. Choose Export Character(s) from the File menu. The Export 
Character(s) dialog appears:
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®  Export ail characters in !ont 
O Export the following text:

I PK J
| ^ Cancel-,“J

O Character outlines only Size: |250 
®  Filled characters

| points

3. Enter the characters to be exported in the text box and choose 
the Export the following text option. Or, choose Export all 
characters in font if you want to export the entire font.

NOTE: The characters you choose are all exported in a single 
graphics file. I f  you want one character per file, you must export 
each character individually.

4. Choose Character outlines only or Filled characters,
depending on the way you want the characters to appear in 
the graphics file.

Enter a size for the characters. The default value of 250 points 
is recommended, because if you make the characters too small 
or too large, you will find them hard to work with in a 
graphics program.

Choose OK. A second dialog appears:

5.

6.

File Name:

bachbl O.ttf
b a c h b ll.lt l
bacho9.it!
bachr12.tif
boler1.it!
hande2.lt!
hande3.tt!
hande4.lt! SI

Directories: J"
c: \f monger\samples\classic

Save File as Jype:
| Illustrator 1.1 for PC

Drives:

7. Enter a name for the graphics file and choose a directory 
location.
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8. Choose an appropriate file format from the Save File as Type 
drop-down list. You may choose Encapsulated PostScript, 
Adobe Illustrator 1.1 or Windows Metafile formats.

9. Choose OK to export the characters.

Creating custom selection ranges
If you find you need to select the same range of characters over 
and over again in the keyboard window, you can automate the 
process by defining your own selection ranges and adding them 
to the Edit menu. You can also assign a keyboard shortcut to any 
selection range.

To create a new selection range:

1. In any keyboard window, select the characters you want to 
include in your custom selection range, using any of the 
selection techniques discussed earlier.

2. Choose Customize Range from the Edit menu. The Customize 
Selection Range dialog appears.

3. Enter an identifying name for the selection range you're 
creating in the Name text box.

4. Choose OK.

The selection range now appears on the Edit menu, and can be 
used to select characters in any keyboard window.

The Customize Selection Range dialog
The Customize Selection Range dialog also allows you to redefine 
or rename existing selection ranges, delete selection ranges from 
the Edit menu and assign keyboard shortcuts to specific selection 
ranges.

Saved Selection Ranges: ~ Customization: “ p m - m  \
0 3
A-Z
a-z

O Update 
®  New 
O Rename 
O CtrkKey 
O Delete

I1 dft&j ’ 9

Ctrl+| |Name: |Special Characters! |
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To redefine an existing selection range
1. In any keyboard window, select the characters you want to 

include in the new selection range definition.

2. Choose Customize Range from the Edit menu. The Customize 
Selection Range dialog appears.

4. In the Saved Selection Ranges list box, select the name of the 
selection range you want to redefine. The Update option 
button becomes selected automatically.

5. Choose OK.

To delete a selection range
1. In any keyboard window, choose Customize Range from the 

Edit menu.

2. In the Saved Selection Ranges list box, select the name of the 
selection range you want to delete.

3. Choose the Delete option button.

You can perform steps 2 and 3 in any order.

4. Choose OK.

To rename a selection range
1. In any keyboard window, choose Customize Range from the 

Edit menu.

2. In the Saved Selection Ranges list box, select the name of the 
selection range you want to rename.

3. Choose the Rename option button.

You can perform steps 2 and 3 in any order.

4. Enter a new name for the selection range in the Name text box 
and choose OK.

To assign a keyboard shortcut to a selection range
You can assign a keyboard shortcut, consisting of the Ctrl key in 
combination with any of the number keys 0-9, to any selection 
range.

You can make the assignment while defining a new selection 
range, or while renaming an existing one.
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Chapter 7, Alter Character Windows
Although a keyboard window is useful for making changes to 
many characters at one time, you often need to focus on a specific 
character to make more detailed changes.

The Alter Character window allows you to make the following 
kinds of changes to one character at a time:

• You can scale, move, slant or rotate entire characters.

• You can construct fractions and composite characters — 
characters which are made up of other characters.

• You can edit the outlines which make up the characters. 
Editing of character outlines is discussed in Chapter 8.

Opening an Alter Character window
To open an Alter Character window, start from the keyboard 
window and:

• select a character and choose Alter Character(s) from the 
Alterations menu, or

• select a character and press Enter, or

• double-click on a character.

The Alter Character window looks like this:
„ Character display area shows
Character name enlarged view of zharacter



a b c

1
2

A

I NOTE: You can only open one Alter Character window per font at 
one time.

Character type buttons
The first four of the five buttons indicate the type of character 
shown in the window:

• The Composite Character button indicates a character which is 
made up of other characters, known as its components.

• The Diagonal Fraction button indicates a fraction with a 
diagonal separator bar between its top and bottom parts. 
Fractions are special kinds of composite characters.

• The Horizontal Fraction button indicates a fraction that has a 
horizontal separator bar.

• The Normal Character button indicates a non-composite 
character.

The fifth button is the Outline Editing button. You click on it to 
begin editing character outlines, as explained in Chapter 8.

Fractions and composite characters are discussed later in this 
chapter.

Character display area
The main part of the Alter Character window displays an 
enlarged view of the character being altered. This area of the 
window is known as the character display area.

As well as the character itself, the display area has:

• Rulers that show you the character size and placement. Unlike 
any ruler you're used to, FontMonger's rulers do not measure 
distances in real-world units like inches or centimeters. 
Instead, the rulers measure distances in Vioooths of a font's 
point size.

• Construction lines which let you align your characters 
properly.

The horizontal line extending from the zero point on the side 
ruler is the character baseline. It is the position at which the 
bottoms of most characters align. (Exceptions include letters 
with curved bottoms, such as 'o' and 'c', which generally
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extend slightly below the baseline, and letters like 'p' and 'g', 
which extend a long way below the baseline.)

The two vertical lines represent the character origin and 
advance width. The distance between these two lines is the 
amount of space that is allocated to the character when it is 
used in a line of text. (Wide letters, such as'm ' or 'w', need a 
larger space than narrow letters like 'i' or 'j', to prevent 
adjacent letters from overlapping.)

There are also two extra guide lines — one horizontal and one 
vertical — which you can position anywhere on the display area. 
See "Using guide lines" later in this chapter.

Tools
Of the five tools in the Alter Character window toolbox, only two 
are used for making the alterations described in this chapter.

• The arrow tool is used to scale, reposition, slant and rotate the 
character in the display area.

• The magnifier tool is used to zoom in or out.

The other three tools are only available when you are editing 
outlines.

Readouts
The readouts text boxes show the amount of scaling, 
repositioning, slanting or rotation that has been applied to the 
character in the display area.

In addition, you can type values directly into the readouts, to alter 
the character numerically.

Altering a character
Applying built-in alterations
You can apply any of the built-in alterations from the Alterations 
menu to the character in the Alter Character window. After 
applying a menu alteration, you can fine-tune the alteration by 
any of the other methods described in this section.

Choose Normal from the Alterations menu to remove all 
alterations from the character.
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Using the arrow tool
Since the arrow tool is normally the active tool in the Alter 
Character window, you usually don't have to do anything to 
activate it. If another tool is active, simply click on the arrow tool 
icon to activate it.

You can also activate the arrow tool temporarily by holding down 
the Ctrl key.

The simplest alteration you can make with the arrow tool is 
repositioning the character. Simply drag the character in the 
display area to the position you want.

As you drag, the Horizontal and Vertical text boxes in the 
readouts panel show you how far the character has moved from 
its original position.

Note that as you move the character horizontally, FontMonger 
automatically adjusts the advance width so that the character 
keeps approximately the same amount of space on its left and 
right sides.

To scale, slant or rotate a character:

1. Click on the character in the display area.

The character's bounding box — a rectangle that encloses the 
character — appears. On the sides and comers of the 
bounding box are five "handles" that you can drag:

a

^Wrdtfr 100
^Height ’ 1QQ , *
•* Horizontal,” r < <

V e rtica l;. ‘
’Slant 0 , >
Rotate .0  - ' -
Char Width 375
Context

» - f i v: ,-<5 % f, ..K . . T*i
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2. Drag one of the handles.
Drag up or down to scale 

the character vertically

Drag to rotate 
the character

Drag to scale the character 
/  horizontally and vertically 

/ (hold down Shift to scale 
proportionally)

- Drag left or right to scale the 
character horizontally

Drag left or right to 
slant the character

As you drag:

• the %Width and %Height readouts text boxes show the 
percentage by which the character has been scaled.

• The Slant readouts text box shows you the amount of the 
slant, in degrees.

• The Rotate readouts text box shows you the amount of the 
rotation, in degrees.

3. When you've finished dragging, you can make the bounding 
box disappear by clicking in any empty part of the display 
area.

Typing alteration values
The readouts text boxes give you a way of scaling, repositioning, 
slanting or rotating a character to specific numerical values:

1. Click on the text box that contains the value you want to 
change. The text box becomes active and its contents are 
selected.
W id th  , 100
^Height \ m

♦Horizontal ’
♦Vertical
S lan t' 0
Rotate ” - 7 0
Char Width 360
Context: ' ’. ! , '

-Active text box

Press Tab to activate next text 
box in top-to-bottom sequence

Press Shift+Tab to activate 
previous text box
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2. Enter the desired value.

• For the %Width and %Height text boxes, the values are 
percentages, so the value 100 is "normal."

You can type a minus sign in front of the percentages to 
"flip" the character. A negative width flips the character 
horizontally, and a negative height flips the character 
vertically:u n
Width: 100% Width: -100% Width: 100% Width: -100%
Height: 100% Height: 100% Height:-100% Height:-100%

The largest percentage you can enter is 1000% (to enlarge 
the character by a factor of 10)

• For the Horizontal and Vertical move text boxes, the 
values are Vioooths of the point size.

Values greater than zero move the character up and to the 
right. Values less than zero move the character down and 
to the left.

• For the Slant text box, the value is in degrees. Values 
greater than zero slant the character to the right, while 
values less than zero slant to the left.

k  k
Slant 12° Slant-12°

The value you enter can be from -45 degrees to 45 degrees.
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• For the Rotate text box, the value is also in degrees. Values 
greater than zero rotate the character counterclockwise, 
and values less than zero rotate clockwise.

Rotate 90 ° Rotate -90 °

The value can be between -360 degrees and 360 degrees.

After a short pause, the character display is updated to reflect 
the value you entered.

3. If the alteration is not what you want, change the value in the 
text box. You can experiment with different values until you 
get the effect you want.

4. Press Enter to deactivate the text field.

Using guide lines
FontMonger provides you with two guide lines — one horizontal 
and one vertical — which you can use to align characters in the 
display area.

Initially, the guide lines are positioned at the zero points of the 
rulers, so they are superimposed on the baseline and character 
origin construction lines.

To reposition the guide lines:

1. Move the mouse pointer over the guide line icon on the top or 
side ruler. The pointer changes to a cross when you are over 
either icon.
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2. Drag the icon along the ruler to a new position.
1-500 0 [pi 500 ( 1000 | 1500

While you drag, the numerical position of the guide line is 
shown in the Horizontal or Vertical readouts text box.

When you drag a character with the arrow tool, the edges of the 
character "snap" to the guide line positions as you approach them. 
The guide lines are highlighted while the character is close 
enough for snapping to occur.

Snapping makes it easy for you to align characters to specific 
locations in the display area. This is especially useful when you 
need to align the components of a composite character.

Snapping is enabled whenever the Snap To Guide Lines menu 
item has a check mark beside it. If you don't want the character to 
snap to the guide lines when you drag, choose Snap To Guide 
Lines from the Options menu to remove the check mark.

Context characters
You may often want to see what a character looks like beside 
another character, or to alter a character in relation to other 
characters of the font. For example, you might want to scale a 
character so that it matches the height of another character.

It is convenient to display the character to be altered in context — 
that is, beside another character you need to compare it to.

FontMonger lets you do this by typing one or more characters in 
the Context text box. These characters are called context characters.

Context characters are displayed both before and after the 
character in the display area:
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I NOTE: Since the display area is limited in size, there usually isn't 
room to show more than one or two context characters.

You activate the Context text box in the same way as a numeric 
readouts text box — by clicking on it or tabbing to it — and you 
deactivate it by pressing Enter.

When you no longer need the context characters, just delete the 
contents of the Context text box.

Adjusting the character advance width
A character's advance width is so named because of the way 
computers place characters in a line of text that is displayed on 
your screen or printed on your printer.

After placing the first character, the software constructing the line 
"advances" a certain distance along the line before placing the 
next character. This process of advancing is repeated character by 
character along the line.

mit
I___________ i___i____ I

advance advance advance 
width of width of width of 
'm' T T
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In spite of the simplicity of this process, advance widths must be 
carefully designed for a font (along with the shapes of the 
characters themselves) so that the tiny gaps that separate 
characters appear well balanced to the reader. Irregularities in the 
spacing can make a line of text difficult to read.

As you apply alterations to a character, you may need to adjust 
the advance width so that the correct spacing is maintained.

One way to check a character's spacing is to view it between 
context characters. If the character overlaps the context characters, 
or if there is a large gap between it and the context characters, you 
may need to adjust the advance width.

There are two ways to change the advance width:

• Activate the Char Width text box (by clicking on it or tabbing 
to it), and type a new value for the width. This value is in 
Hoooths of the point size, and may not be less than zero.

• With the arrow tool, drag on the context character displayed to 
the right of the character in the display area.

NOTE: Repositioning the character and scaling the character make 
compensating changes to the advance width. Generally, if you plan 
to change a character's advance width, you should first finalize all 
other alterations to the character.

Undo and Redo
Undo allows you to reverse the changes you've most recently 
made to a character in the Alter Character window.

FontMonger remembers the last eight changes you made, and 
undoes them in order as you choose Undo from the Edit menu. 
The text of the menu item changes to show you the kind of change 
being undone.

Redo from the Edit menu allows you to reapply changes that 
you've undone.

FontMonger keeps track of the changes in each Alter Character 
window separately. If you have Alter Character windows open for 
more than one font, you can undo up to eight changes in each 
window.
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Saving altered characters
The changes you make in an Alter Character window have no 
effect on the rest of the font until you take one of the following 
specific actions:

• You close the Alter Character window.

• You save the entire font by choosing Save or Save As from the 
File menu.

• You switch to a different character in the Alter Character 
window. (See "Altering multiple characters" later in this 
chapter.)

When you take one of these actions, the altered character replaces 
the original character on the appropriate keycap.

NOTE: None o f the alterations described in this chapter affect any 
characters other than the one you apply them to in the Alter 
Character window. For example, i f  you alter the 'a' character, any 
accented 'a' characters in the font are unchanged.

Contrast this with outline editing, where a change to the outlines o f  
letter 'a' would also change any composite accent character that 
uses 'a' as a component.

Controlling the display
FontMonger provides you with several ways of controlling the 
way the Alter Character window display area appears.

Resizing fhe display
If the display area is too small, you can make it bigger by simply 
resizing the Alter Character window. Be aware, though, that a 
large display area requires a lot of memory, especially if you have 
a color or gray-scale screen.

If you make the display area very large, you will find boundaries 
beyond which the area is gray. You should ensure that your 
characters stay within the white part of the display area.

I NOTE: Characters that extend into the gray area may not appear 
correctly when you install your font, since the software that
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displays or prints characters has built-in limitations on the size and 
complexity o f a single character.

Using the magnifier tool
You can zoom in or out on the character in the display area — that 
is, increase or decrease the scale at which the character is 
displayed — by using the magnifier tool. The magnifier can also 
"toggle" between the last two display scales you used.

Q  The magnifier is activated by clicking on the tool's icon in the
toolbox. You can also activate the magnifier tool temporarily by 
holding down one of the following keys:

Space
F2
F3

To zoom in
1. Activate the magnifier tool by clicking on its icon in the 

toolbox.

Or, press and hold the Space key.

Or, press and hold the F2 key.

(+^ The mouse pointer changes to a magnifying glass with a plus
sign in its center. If there's no plus sign, the display area is 
already at its maximum scale, and cannot be magnified any 
further.

2. Click on the display area.

Or, drag to mark a rectangle on the display area.

If you click, the display area is magnified one step, and the 
place you clicked on stays in the same place in the window.

If you drag, the area you marked is magnified to fill the 
display area.

To zoom out
1. Activate the magnifier tool by clicking on its icon in the 

toolbox, then press and hold the F5 key.

Or, press and hold the Space and F5 keys simultaneously.

Or, press and hold the F3 key.
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The mouse pointer changes to a magnifying glass with a 
minus sign in its center. If there's no minus sign, the display 
area is already at its minimum scale, and cannot be reduced 
any further.

2. Click on the display area.

The display area is reduced in scale by one step, and the point 
you clicked on stays in the same place in the window.

To toggle the scale
FontMonger remembers the last two magnifications of the display. 
You can quickly switch ("toggle") between these two 
magnifications:

1. Activate the magnifier tool by clicking on its icon in the 
toolbox, then press and hold the Shift key.

Or, press and hold the Space and Shift keys simultaneously.

Or, press and hold the F2 and Shift keys simultaneously.

The mouse pointer changes to a double magnifying glass.

2. Click anywhere on the display area.

The display area changes to the previously remembered 
magnification.

NOTE: You can press F6 instead o f the Shift key in step 1.
Depending on the arrangement o f keys on your keyboard, F6 may 
be easier to reach than the Shift key for  some combinations.

Scrolling the display area
You can scroll the contents of the display area using the vertical 
and horizontal scroll bars at the left and bottom of the display 
area.

Another way to scroll the window is to use the grabber tool:

1. Press and hold the F4 key to activate the grabber tool.

The mouse pointer changes to a hand.

2. Drag the display area in any direction. The place on the 
display that you "grabbed" follows the mouse pointer while 
you drag.
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Creating fractions
FontMonger provides you with an automated way of creating two 
kinds of fractions — "diagonal" fractions and "horizontal" 
fractions.

A fraction is made up of three parts:

Numerator

Separator

Denominator

When creating fractions in an Alter Character 
window, you need only enter the numerator and denominator. 
FontMonger supplies the appropriate separator automatically. It 
also sizes and positions the parts of the fraction.

How to create a diagonal fraction
Before creating a diagonal fraction you must decide which key on 
the keyboard you want the fraction to be associated with.

If the font has unused key positions (shown in the keyboard 
window as keycaps with a gray character on them), you can use 
one of them for the fraction. Otherwise, you will have to reuse one 
of the keys that has a character assigned.

To create the fraction:

1. Open an Alter Character window for the character position 
you chose.

2. Click on the Diagonal Fraction button. The Fraction Top and
Bottom text boxes appear above the button in the window.

The text boxes are pre-filled with the values 1 and 2, so the 
display area shows you the fraction
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1
2

Enter the numerator here

-Enter the denominator here

3. Enter the numerator in the Fraction Top text box.

4. Activate the Fraction Bottom text box by clicking on it or 
tabbing to it, then enter the denominator of the fraction you 
want.

NOTE: I f  you want to use a separator character other than the one 
FontMonger automatically chooses, there is a procedure for  
changing it. See "Editingfractions and composite characters" 
below.

How to create a horizontal fraction
The procedure for creating a horizontal fraction is identical to the 
procedure for creating a diagonal fraction, except that you must 
click on the Horizontal Fraction button instead of the Diagonal 
Fraction button.

Changing between fraction types
After you've constructed a fraction, you can change it from a 
diagonal fraction to a horizontal fraction and vice versa by simply 
clicking on the appropriate fraction button.

Creating composite characters
Composite characters are similar to fractions in that they are made 
up of several parts, or components. The difference is that you 
decide how many components to use, and how to position the 
components.

To create a composite character:

1. Choose a key to use for the composite character, and open an 
Alter Character window.

2. Click on the Composite Character button. The Components 
text box appears above the button.
Components llabc —̂ ____________________ Enter the components here

3. Type the characters you want to use as components. The
characters you enter are shown in the display area in the order 
in which you entered them.
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NOTE: You can also use characters in the font that can't be 
accessed from the keyboard. See "Entering special characters into a 
text box" for the procedure to follow.

At this point you've created a composite character which is 
composed of all the components you entered into the 
Components text box.

It's likely that you still need to alter —  by scaling, repositioning, 
slanting or rotation —  the components of the character you've 
created. The following section explains how you can do this.

Editing fractions and composite characters
Even though you create them differently, fractions and composite 
characters are all single characters made up of separate 
components.

Fractions and composite characters can be altered in the same 
ways as a normal character —  by scaling, moving, slanting or 
rotating the entire character. However, FontMonger also allows 
you to make the same kinds of alterations to individual 
components or combinations of components without affecting 
other components.

To alter one component of a composite character or fraction:

1. Double-click on the character to break it apart into separate 
components. Each component is now shown with its own 
bounding box.

Fraction Top 11
Bottom 2

I  A
Width

Horizontal
♦Vertical
Slant 
Rotate 
O i k  Width
Context

65 
60____

0_
0_
■ 1
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The component that has the handles is called the current 
component.

For a composite character, the number of components is the 
same as the number of characters you entered in the 
Composite text box. For a fraction, there are always three 
components: the numerator, the denominator and the 
separator.

2. Now make the alterations you want.

• To reposition any component, simply drag it.

• To scale, slant or rotate any component, first click on it to 
make it the current component (if necessary), then drag 
any of the handles.

• Enter values in the readouts text boxes to make alterations 
numerically. Note that the values in the readouts reflect 
the alterations that have been applied to the current 
component.

3. To re-join the components into a single unit, simply click 
anywhere in the display area outside of the component 
bounding boxes.

You can also alter multiple components simultaneously:

1. Double-click on the character to break it apart.

2. Click on the first component you want to alter so that it 
becomes selected.

3. Hold down the Shift key and click on each of the other 
components you want to alter. The bounding box of each 
component becomes highlighted as you select it.

If necessary, you can Shift-click on an already-selected 
component to deselect it.

Notice that only the last selected component has handles. The 
values shown in the readouts reflect the alterations applied to 
this current component.

4. To see the readout values or handles for a component that has 
already been selected, simply click on the component. The 
selected components remain selected, but the one you clicked 
on becomes the current component.
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5. Make the desired alterations by dragging or typing in the 
readouts.

Changing composites to normal characters
If you decide you don't want a fraction or composite after all, you 
can change back to a normal character by clicking on the Normal 
Character button. The original character (if there was one) is 
restored unchanged.

Changing fractions to composites
When you construct a fraction whose numerator or denominator 
contains more than one digit (e.g. 15/ie), FontMonger does not let 
you alter the digits separately (to move the 1 closer to the 5, for 
example).

If you need this level of fine control, click on the Composite 
Character button to convert the fraction to a composite character. 
You can then reposition or otherwise alter each character of the 
composite separately.

Changing the separator in a fraction
FontMonger normally chooses an appropriate character to use as a 
fraction separator. In special circumstances, though, you may 
wish to use a different character as the separator.

To change the separator character:

1. Create either a diagonal or horizontal fraction, letting 
FontMonger choose the separator character.
FracfcnTpp 15 - j Components of the fraction
BtffljQTO: . _ 1,6. ~~ m 0̂000000̂

2. Click on the Composite Character button
to turn the fraction into a composite. The characters making 
up the fraction numerator, separator and denominator appear 
in order in the Composite text box.

-̂------------Characters making up the fraction
~~  I:__ !____I become components of the composite

3. Replace the separator in the text box by deleting it and typing 
the character you want to use.

4. Click on the Diagonal or Horizontal Fraction button again to 
turn the composite back into a fraction.
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NOTE: Don't change any o f the other components while the 
composite button is highlighted, or FontMonger may lose track o f 
which character is the separator.

Entering special characters into a text box
Although you can type any characters into the Components, 
Fraction Top or Fraction Bottom text boxes, you may also want to 
use a character that is not accessible from the keyboard.

For example, if you want to create an accented i, you should not 
make a composite consisting of a regular i plus an accent, because 
the dot on the i will interfere with the accent.

Instead, you should create a composite consisting of a dotless i 
character plus an accent. Most fonts have a dotless i, but the 
character can't be accessed from the keyboard.

You can enter such characters by using the Choose Character 
dialog:

1. In an active text box, position the flashing insertion point at 
the place where you want to insert the non-keyboardable 
character.
Cqnfl%nen£

2.

- Insertion point indicates the 
place where the special 
character will be inserted

Or, select the characters you want to replace with the non- 
keyboardable character.

Choose Choose Character from the Edit menu. The Choose 
Character dialog appears:

oosejGHaracter

r f r i
quoteright quotesinglbase quotesingte r

® • s i
registered ring s scaron

1 ♦
f 7 6

section semicolon seven six

/ £ t
slash space sterling t
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3. Scroll through the character list until you find the character 
you want to insert.

4. Select the character and choose OK, or just double-click on the 
character.

Special characters that you enter into a text box this way are 
displayed as small hollow boxes.

laob 1-----------Box indicates non-keyboardable character

Changing the text box font
When you type in the Components, Fraction Top or Fraction 
Bottom text boxes, the characters within the text box are shown in 
a special font that is built into FontMonger.

This special font is similar to the system font provided with the 
U.S. version of Windows, except that it can represent almost all of 
the 256 characters in the Windows ANSI character set.

If you have a non-U.S. Windows system, or are using a special 
system font, you may wish to have the characters in text boxes 
appear in your own system font.

You can do this by choosing Use System Font from the Options 
menu while an Alter Character window is active.

Altering multiple characters
FontMonger allows you to alter multiple characters without 
closing the Alter Character window and opening a new one for 
each character. To do so, you employ one of the following 
techniques to change the character displayed in the window:

Switch characters by typing
With an Alter Character window open, and no readouts text box 
active, you can switch to a different character by typing it on your 
keyboard.

When the new character appears, alterations you made to the old 
character are not lost, but take effect in the font as if you closed the 
window.
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Previous and next characters
You can switch to the previous or the next character in the font by 
choosing Previous Character or Next Character from the 
Alterations menu. The keyboard shortcuts for these menu items 
are Ctrl+left arrow and Ctrl+right arrow, respectively.

The meaning of "next" and "previous" depends on what is 
selected in the keyboard window.

• If multiple characters are selected in the keyboard window, 
Previous Character and Next Character switch to the previous 
or next selected character, in the order of the selection.

• If only a single character is selected in the keyboard window, 
or if no characters are selected, Previous Character and Next 
Character switch to the previous or next character in the font, 
in alphabetical order by character name.

The character name is shown in the title bar of an Alter 
Character window.

In the second case (with no characters or one character selected), 
Previous Character and Next Character step through all 
characters in the font, regardless of whether they are currently 
assigned to keyboard positions or not.

Creating and using custom alterations
The built-in alterations on the Alterations menu can be applied 
both to ranges of characters in the keyboard window, or to single 
characters in the Alter Character window.

FontMonger does not restrict you to the built-in alterations, 
though. You can create your own custom alterations, which 
appear on the Alterations menu along with the built-in ones.

To create a new custom alteration
1. Alter one character using any of the procedures explained 

earlier in this chapter — but don't close the Alter Character 
window when you're done.

2. Choose Customize Alteration from the Alterations menu. The 
Customize Alteration dialog appears.
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3. Type the name you want to assign to your custom alteration in 
the Name text box.

4. Choose OK. The name of your custom alteration will then 
appear in the Alterations menu.

You can apply a custom alteration in the keyboard window or the 
Alter Character window just like the built-in alterations.

I NOTE: You can't save outline editing changes as part o f a custom 
alteration.

The Customize Alteration dialog
The Customize Alteration dialog allows you to create new 
alterations, change the effects of both built-in alterations and 
alterations you previously created, rename alterations, delete 
custom alterations and assign keyboard shortcuts to specific 
alterations.
The Customize Alteration dialog looks like this:

3fv."' • ■■ ■ Gustbm i Alteration

Saved Alterations: " Customization:' L_ ok _JI
Small Caps O Update 

<§> New 
O Rename 
O Ctrl+Key 
O Delete

Slant
Superior
Inferior

|. Cancel 9 !

crn+l |Name: | New Alteration 1

To update an existing alteration
1. In an Alter Character window, choose the alteration's name 

from the Alterations menu.

This step is not absolutely necessary, but helps ensure that you 
don't accidentally change some part of the alteration that you 
want to retain.

2. Revise any parts of the alteration that you want to change, by 
any of the usual techniques for making alterations.

3. Choose Customize Alteration from the Alterations menu. The 
Customize Alteration dialog appears.
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4. In the Saved Alterations list box, select the name of the 
alteration you want to update. The Update option button is 
automatically selected.

5. Choose OK.

You can update built-in alterations as well as custom alterations
you created.

To delete a custom alteration
1. In an Alter Character window, choose Customize Alteration 

from the Alterations menu.

2. In the Saved Alterations list box, select the name of the 
alteration you want to delete. You cannot delete a built-in 
alteration.

3. Choose the Delete option button.

You can perform steps 2 and 3 in any order.

4. Choose OK.

To reset a built-in alteration
Although you cannot delete any of the built-in alterations, you can
reset them to their original default values:

1. In an Alter Character window, choose Customize Alteration 
from the Alterations menu.

2. In the Saved Alterations list box, select the name of the built- 
in alteration you want to reset. The Delete option button 
changes to Reset.

3. Choose the Reset option button.

4. Choose OK.

To rename an alteration
1. In an Alter Character window, choose Customize Alteration 

from the Alterations menu.

2. In the Saved Alterations list box, select the name of the 
alteration you want to rename. This can be a built-in alteration 
or a custom alteration.
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3. Choose the Rename option button.

You can perform steps 2 and 3 in any order.

4. Enter a new name for the alteration in the Name text box.

5. Choose OK.

To assign a keyboard shortcut to an alteration
You can assign a keyboard shortcut, consisting of the Ctrl key in 
combination with any of the number keys 0-9, to any alteration — 
built-in alterations as well as custom alterations.

You can make the assignment while creating a new alteration or 
renaming an existing one, or:

1. In an Alter Character window, choose Customize Alteration 
from the Alterations menu.

2. In the Saved Alterations list box, select the name of the 
alteration you want to assign a shortcut to.

3. Choose the Ctrl+Key option button.

You can perform steps 2 and 3 in any order.

4. Type a number 0-9 in the Ctrl+Key text box.

5. Choose OK.

NOTE: Your custom alterations are kept in the FontMonger 
preferences file, named FMONGER.PRF in the same directory as 
FMONGER.EXE. I f  you delete this file, all your custom alterations 
will be lost, and all the built-in alterations will be set back to their 
original default values.
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Chapter 8. Editing Outlines
FontMonger provides you with a full set of character drawing 
tools that you can use to edit existing characters or draw new 
characters.

Before you use the drawing tools, you should be familiar with the 
Alter Character window. In particular, you need to be able to 
carry out the following procedures, which are described in 
Chapter 7:

• Open and close an Alter Character window, and switch 
characters within an open Alter Character window.

• Resize the character display area, and zoom in or out.

• Scroll the character display area with the scroll bars or the
grabber tool.

• Use horizontal and vertical guidelines.

• Enter values in the readouts text boxes.

Characters and outlines
You are used to seeing characters as solid, black-filled shapes. 
When you want to edit the character shapes, you must look below 
the black-filled surface to the underlying building blocks of 
characters.

Character as printed 
or displayed

Underlying outline Outline as shown 
in FontMonger

Characters are designed, drawn and edited in a skeletal form 
called an outline. An outline represents the character's edges.

When a character from a scalable font is displayed on the screen 
(by Windows 3.1 or Adobe Type Manager, for example) or printed



(by the software inside your printer), the interior portions of the 
character's outlines are filled with black. Everything else is left 
unfilled, allowing the color of the screen or paper — normally 
white — to show through.

As you edit a character outline, it is your responsibility to ensure 
that the correct portions of the shape are fully enclosed, so that the 
character is filled properly when displayed or printed.

Normally, FontMonger displays all characters (in a font's 
keyboard window or in the alter character window) filled in the 
same way they'll appear when you use the font.

When you begin outline editing, FontMonger displays characters 
differently. Character edges are displayed as lines, and the interior 
of the outline is left unfilled.

Paths
Each character outline is made up of separate lines called paths. If 
you trace along the paths of some existing character outlines, you 
will see that each path is a closed loop — if you start anywhere on 
the path and follow it around, you'll eventually get back to where 
you started.

Also, you will see that no path crosses over 
itself, and no path crosses any other path.

These two observations — paths must be closed, and paths may 
not cross — are actually rules you must follow when drawing 
character outlines. If you violate the rules, the character may not 
display or print correctly.

NOTE: These rules apply to completed characters. You may often 
break the rules as an intermediate step in editing character outlines. 
A path that does not form a closed loop is said to be "open."
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The simplest characters, such as "L" and "T," consist of a single 
path. Characters with holes in them such as "O " or characters 
having multiple pieces such as "i" or "% " are composed of two or 
more paths.

Segments and join points
In FontMonger, paths are made up of a series of straight and 
curved segments that are connected together end to end. The 
points where segments connect are called join points, or simply 
joints.

• A corner joint occurs where two segments join.

• A smooth joint occurs where one segment blends smoothly into 
the next one.

Smooth joints can occur between two curved segments or between 
a straight line and a curve. Two straight line segments can only be 
joined by a comer joint.

In the Alter Character window, join points are shown as small 
squares or circles:

If you have an open path in the character display area, the ends of 
the path are marked with a special "starburst" shape so that they 
are easily recognizable.
□-----------------------------□ I3-----------------------------□

¥ 3-----------------------------&

1/ This path is still open —
Open ends although the ends overlap,

they are not joined together
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You should get into the habit of carefully examining any character 
outlines you draw for unwanted starbursts. An open path may 
seem to be closed if the path begins at the same place it ends, but 
it's not truly closed if it contains a starburst.

Shape handles
Join points define where each segment begins and ends. For 
straight line segments, that's all there is to know, but for curved 
segments you also need to be able to control the curvature, so that 
you can get deeper or shallower curves.

Each curved segment has two shape handles, which define how 
much the segment curves and in what direction.

Each join point of a curved segment has its own shape handle. The 
distance of the shape handle from the joint determines how 
sharply the segment curves out from the joint, and the direction of 
the shape handle from the joint determines the direction in which 
the curve travels.

Beginning and ending outline editing
To begin editing a character outline:

1. Open an Alter Character window for the character you want 
to edit.

2. Click on the Outline Editing button, which is the rightmost of 
the five horizontal buttons in the window. The character in the 
display area becomes a hollow outline, and all of the tools in 
the toolbox are enabled.

You can only edit the outlines of a normal character. If you try to 
begin outline editing of a composite character or fraction, 
FontMonger asks you if you want to convert the character to a 
normal character.
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You do not have to end outline editing explicitly in order to have 
your changes take effect. Changes to outlines take effect under the 
same circumstances as character alterations:

• When you close the Alter Character window.

• When you save the font.

• When you switch to another character in the window.

However, if you wish, you can end outline editing by clicking on 
the Normal Character button.

Keep in mind that when you edit a character's outline, you are 
editing the underlying structure of the character. For this reason, 
any alterations such as scaling, moving, slanting and rotation 
you've applied to the character as a whole are suspended while 
outline editing is in progress. The alterations are not lost, though: 
their effects are simply not visible while the Outline Editing 
button is highlighted.

Another consequence of editing the underlying structure is that 
the changes you make affect not only the character in the Alter 
Character window, but also all composite characters which use 
that character as a component.

For example, if you edit the outline of a, corresponding changes 
will occur in the accented composite letters a, a, a, etc.

Drawing a new character
If you want to draw a brand new outline in place of an existing 
character's outline, you must first remove the original outline:

1. Choose Select All from the Edit menu to select all the 
segments in the outline.

2. Choose Delete from the Edit menu, or press the Delete key to 
delete all the segments.

Selecting segments
The purpose of having paths divided up into segments is so that 
you can modify parts of an outline without changing other parts.
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To modify part of an outline, you select the segment (or segments) 
that make up that part of the outline, and carry out some 
operation on the selection.

How selections are displayed
Normally, the squares and circles that mark the join points of an 
outline are hollow. When a segment is selected, the join points at 
each end of the segment become filled in.

If a selected segment is a curve, its shape handles also appear as 
crosses just off the curve.

Using the arrow tool for selection
You usually use the arrow tool to select segments:

1. To activate the arrow tool, click on its icon in the toolbox.

Or, hold down the Ctrl key to activate the arrow tool. The 
arrow tool remains active as long as you hold the key down. 
When you release the key, the previous tool is re-activated.

2. Click on a segment to select it, or double-click on a segment to 
select the entire path.

If you click on a joint between two segments, both segments 
are selected.

Using a selection rectangle
You can select multiple segments in one operation by dragging 
out a selection rectangle.

1. Activate the arrow tool, as described above.

2. Start dragging from some unoccupied part of the display area, 
away from any segments or shape handles.

One corner of an enclosing rectangle stays at the place you 
started dragging. The opposite comer follows the position of 
the mouse pointer.

Sel
segment
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3. Drag out the rectangle so that it encloses the segments you 
want to select.

4. Release the mouse button when the correct segments are 
enclosed.

NOTE: To select all the segments o f the character, choose Select 
A ll from the Edit menu. To deselect all the segments, just click 
with the arrow tool anywhere in the display area away from the 
outline.

Modifying the selection
You can add to or subtract from the current selection by holding 
down the Shift key while making a selection.

• Shift-click on an unselected segment to add it to the current 
selection.

• Shift-click on a selected segment to deselect it.

You can add or subtract whole paths from the current selection by 
holding down the Shift key while double-clicking on a segment. If 
the segment was unselected, the entire path becomes selected. If 
the segment was selected, the entire path becomes deselected.

Using Cut, Copy, Paste and Delete
Selected segments can be cut, copied, pasted and deleted, using 
Cut, Copy, Paste and Delete from the Edit menu or their 
keyboard shortcuts. Segments you cut or copy from one character 
may be pasted into the same character, a different character in the 
same font or a character in another font.

• When you Cut the selected segments, they are removed from 
the character and placed onto the clipboard.
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• Delete also removes the selected segments from the character, 
but doesn't place them on the clipboard.

• Copy places a copy of the selected segments onto the 
clipboard but does not remove them from the character.

• Paste retrieves the contents of the clipboard and places those 
segments into the character as one or more new paths. Pasted 
segments are always placed in the same position they 
occupied when they were copied, even if you paste them into 
another character.

Be careful not to paste extra copies of segments on top of each 
other.

Dragging segments
If you drag a segment, it and any other selected segments will 
move with the mouse pointer to a new position.

Unselected segments that are connected to the segments you drag 
will automatically be reshaped to remain connected to the moving 
segments.

Hold down the Shift key while you are dragging to limit the 
movement to the horizontal or vertical direction.

Dragging join points
You drag a join point to move it. The segments on either side of 
the joint will be automatically reshaped as necessary.

Constraining your drag
Hold down the Shift key as you start dragging a join point to limit 
the direction of movement to an imaginary line connecting the 
join point to its associated shape handle.

Hold down the Shift key after you start dragging a join point to 
limit the movement to the horizontal or vertical direction.
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\ Hold down the Shift 
\ key while you start

Hold down the Shift key 
after you start dragging 
to move the joint along 
either of these lines

\ dragging to move the

Dragging open ends
When you drag the open end of a path over another open end, the 
first open end will "snap" to the location of the other open end 
and a large highlighting circle appears around both points.

If you release the mouse button while the highlighting is still 
visible, the two ends are joined together.

Use this technique to "close" an open path, or to combine two 
separate open paths into a single path.

If you do not want the two open ends to be joined, simply drag a 
little further until the highlighting disappears before releasing the 
mouse.

Dragging shape handles
You can reshape a curved segment by dragging either of its shape 
handles. As you move a shape handle the "fullness" and direction 
of the curve change.

If you drag a shape handle that is associated with a smooth joint 
of a curve, the smoothness of the joint is maintained in one of two 
ways:

• If the curve is connected to another curve, the shape handle of 
the other curved segment moves along with the shape handle 
you are dragging.

• If the curve is connected to a line segment, the shape handle is 
restricted in movement to an imaginary line that extends the 
line segment.
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If you want to drag the shape handle freely without modifying a 
connected segment, first double-click on it to convert its associated 
join point into a comer joint.

Separating a shape handle from a join point
Sometimes a shape handle gets placed directly over a join point 
and can be difficult to drag. You can drag the shape handle away 
from the join point using the following procedure:

1. Deselect any currently selected segments by clicking away 
from any segment or shape handle.

2. Select the segment you want to reshape.

3. Press the mouse button over the join point that obscures the 
shape handle and drag. The shape handle then moves away 
from the join point as you drag.

Modifying joints
You can turn a smooth joint into a comer joint or vice versa 
simply by double-clicking on the join point, or by clicking on a 
shape handle next to the joint.

I NOTE: You cannot change the corner joint between two lines into 
a smooth joint.

The appearance of the join point will change from a circle to a 
square (or vice versa) to indicate the new type of joint.

When you convert a smooth joint into a comer joint, the outline 
itself remains unchanged in shape. However, when you convert a 
comer joint into a smooth joint, the shape of the path may be 
modified to give the required smooth connection:

• If you convert a comer joint between a line and a curve, the 
curved segment is modified.

• If you double-click on a shape handle, the curved segment that 
the shape handle belongs to is modified.

• If you double-click on the join point, either curved segment 
may be modified.
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Modifying segments
You can turn a line segment into a curved segment or turn a 
curved segment into a line by holding down the F5 key while you 
click on the segment.

A curved segment is replaced by a line segment between the join 
points of the curve. A line segment is replaced by a curved 
segment with its shape handles placed evenly between the join 
points.

Other w ays of moving segments and joints 
Precise dragging
Normally, when you drag a segment or joint, it moves with the 
mouse pointer. This means that the smallest distance you can 
move is one screen pixel. Depending on the display magnification, 
this may be 5,10 or even more ruler units. (One ruler unit is 
Moooth of the character's point size.)

You can move a segment or joint by just one unit at a time by 
holding down the F5 key while dragging. For each screen pixel 
that the mouse pointer moves, the segment or joint moves one 
ruler unit.

If you release the F5 key, the segment or joint will jump to the 
current mouse pointer position. You can alternate between 
holding down the F5 key and releasing it at any time while 
dragging.

Using the arrow keys
You can use the left, right, up and down arrow keys on your 
keyboard to move segments, joints or shape handles.

To move a joint or shape handle, first click on it. Notice that the 
small circle, square or cross becomes slightly larger. While a joint 
or shape handle is highlighted in this way, it is affected by the 
arrow keys.

On the other hand, if no joint or shape handle is highlighted, the 
arrow keys affect the selected segment (or segments).

To remove the highlighting, click on a selected segment.
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Each press of an arrow key moves the selected segments, joint or 
shape handle one pixel in the direction of the arrow key. If you 
hold down the F5 key, each press of an arrow key moves the 
selected segments, joint or shape handle one ruler unit.

Moving segments numerically
When no joint or shape handle is highlighted (as described in the 
previous section), you can specify an exact number of units to 
move the selected segments by typing a value in the Horizontal or 
Vertical readouts text box.

Enter a number greater than zero to move up or to the right, and 
enter a number less than zero to move down or to the left.

Moving joints and shape handles numerically
When a joint or shape handle is highlighted, you can use the 
readouts text boxes to move it by an exact number of ruler units, 
or to move it to an exact position.

To move the joint or shape handle by an exact distance, enter a 
value into the Horizontal or Vertical text box.

Notice that when a joint or shape handle is highlighted, the top 
two text boxes change to Current X and Current Y. These give the 
position of the joint or shape handle in ruler units.

You can move the highlighted joint or shape handle to another 
position by entering new values into either text box.

Using the scissors tool
You can add or remove join points and split paths using the 
scissors tool. Activate the scissors tool by clicking on its icon in the 
toolbox.

Adding and deleting joints
To add a joint, click on a path where you want the new joint.

To remove a joint, hold down the F5 key and click on the joint you 
want to remove.

When a joint is removed, the segments on either side are 
combined mathematically into a single segment that closely 
matches the original segments.
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NOTE: I f  you remove too many smooth join points or a corner 
point from a path, the shape o f your character may change 
unacceptably.

Splitting a path with the scissors tool
To split a path, double-click where you want the split to occur.

You can double-click within a segment, to break the segment into 
two parts and split the path between the parts, or double-click on 
a joint, to break the path at the joint.

Either way, the place you double-clicked now has two 
overlapping open ends, indicated by a "starburst."

Using the gizmo tool
The "gizmo" tool is a combination tool that can scale, slant and 
rotate entire outlines or selected segments.

m Activate the gizmo tool by clicking on its icon in the toolbox. 
While the gizmo is active, a circular anchor icon appears in the 
display area, initially at the character origin.

The center of the anchor is the point about which scaling, slanting 
or rotation will occur. You can move the anchor to any desired 
location simply by dragging it.

NOTE: As you drag, the anchor automatically "snaps" onto joints 
and the character origin. You can prevent the snapping by holding 
down the Shift key while you drag.
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The anchor is divided into four sections: 
slant i —_ rotate

scale

Three of the sections contain icons representing slanting, rotation
and scaling. (The fourth section is currently unused.) Click on the
section corresponding to the action you want to perform.

To scale an outline
1. Select the segments you want to scale. If no segments are 

selected, the whole character will be scaled.

2. Click on the scale icon in the bottom right section of the 
anchor.

3. Move the mouse pointer anywhere in the display window 
(except over the anchor icon) and start dragging.

A rectangle with a diagonal line inside is drawn from the 
anchor to the mouse position to show the amount of scaling. 
As you drag, the selected segments are resized in proportion 
to the distance you have dragged. The %Width and %Height 
text boxes show the corresponding scale percentages.

4. To scale by equal amounts in both the vertical and horizontal 
directions, hold down the Shift key and drag at an angle of 
approximately 45 degrees from the anchor.

5. To scale only in the vertical or horizontal direction, hold down 
the Shift key and drag vertically or horizontally away from 
the anchor.

You can also enter a scaling percentage into either the %Width or
%Height text box.

To slant an outline
1. Select the segments you want to slant. If no segments are 

selected, the whole character will be slanted.

2. Click on the slant icon in the top left section of the anchor.
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3. Move the mouse pointer anywhere in the display window 
(except over the anchor icon) and start dragging.

A line appears from the center of the anchor to the mouse 
pointer location to give you a visual reference for the amount 
of slant you are applying. As you drag, the selected segments 
are slanted by the amount you have dragged. The Slant text 
box shows the corresponding slant angle.

Alternately, you can enter a slant angle into the Slant text box.

To rotate an outline
1. Select the segments you want to rotate . If no segments are 

selected, the whole character will be rotated.

2. Click on the rotation icon in the top right section of the anchor.

3. Move the mouse pointer anywhere in the display window 
(except over the anchor icon) and start dragging.

A line appears from the center of the anchor to the mouse 
pointer location to give you a visual reference for the amount 
of rotation you are applying. As you drag, the selected 
segments are rotated by the amount you have dragged. The 
Rotate text box shows the corresponding rotation angle.

You can also enter a rotation angle into the Rotate text box.

Using the pen tool
The pen tool is used to draw outlines — one segment at a time. 
Activate the pen tool by clicking on its icon in the toolbox.

Establishing a current point
The first step in drawing with the pen tool is to establish the 
current point to which you will append segments. You establish 
the current point by clicking on a blank spot in the display, which 
draws a single "starburst" at the click position.

^  Establishing the current point for a new path

Alternatively, you can click on the open end of an existing path to 
make it the current point for subsequent drawing.
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Establishing the current point when 
linking onto an existing path

After you establish the current point, you can add straight or 
curved segments.

Drawing straight line segments
To draw a straight line segment from the current point to another 
point, just position the mouse at the second point and click. A line 
is drawn from the current point to the mouse position. The point 
you clicked on becomes the new current point.

• If you add a line segment by clicking on the opposite end of 
the path you are drawing, the path is closed with a line 
segment between the current point and the opposite end of the 
path.

After the path is closed, there is no current point. If you wish 
to continue drawing, establish a new current point by either 
clicking in a new blank spot or by clicking on an end of 
another open path.

• If you hold down the Shift key while you click to create a 
straight line segment, the line segment is drawn either 
horizontally or vertically from the current point to the mouse 
pointer's vertical or horizontal position, depending on which 
is closer to the actual mouse position.

Drawing curved segments
To draw a curved segment:

1. Move the mouse pointer over the current point and drag out a 
shape handle.
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>
Hold down the Shift key as you drag out the shape handle if 
you are connecting to an existing segment and you want a 
smooth joint. Otherwise you will get a corner joint.

2. Move the mouse pointer to the position at which you want the 
curve to end. Drag away from this position to shape the curve 
as needed.

If you want to continue by adding a curve that is smoothly 
connected to the previous curve, repeat step 2. If you want to 
continue by adding a curve that is connected by a comer joint, 
repeat from step 1.

Adding a straight line segment to a curve
If you want to add a straight line segment from the end of a 
curved segment you have just drawn, just move the mouse 
pointer to the place where you want the line to end and click.

Adding a curved segment to a straight line
To add a curved segment to a line segment, use the procedure 
described in "Drawing curved segments."
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Closing a path with a curve
To close a path with a curve (or to join two paths) with a curved 
segment:

1. Move the mouse pointer over one end of a path and drag out a 
shape handle.

Hold down the Shift key as you drag out the shape handle if 
you want a smooth joint. Otherwise you will get a comer joint.

2. Move the mouse pointer over the other end of the path (or an 
end of another path). Drag away from this position to shape 
the curve.

Hold down the Shift key as you start dragging to join the 
curve smoothly.

Starting a new path
If you have drawn a path with the pen tool but not yet closed it, 
and you want to start drawing another path, you must first 
eliminate the current point.

You can do this by activating any other tool from the toolbox.
Then click on the pen tool icon in the toolbox to reactivate the pen.

Merging outlines
Often, character shapes appear to be created by overlapping 
different shapes. For instance, a dollar sign looks like a vertical bar 
shape drawn through an 'S' shape.

But if you actually draw a character this way, you break one of the 
important rules of character design — that paths must not cross 
over each other.

FontMonger has the ability to take an "incorrect" character design 
like this and remove the overlapping parts of the paths, resulting
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in a "correct" character that has the same shape. This process is 
known as merging outlines.

To construct a character using this technique:

1. Construct the outline using overlapping paths.

. V  , , , , iso*;*,■ ■ • 1 - v '1 -

; ^  =\ J

:

S*g .3*SS»M b *  1
iHctajer . i« ,£» a.

i  , 1---1

2. Choose Merge Outlines from the Edit menu. FontMonger 
computes all the intersection points of the paths, removes the 
extra segments between the intersections and joins the 
resulting pieces together into a well-formed outline.

If you forget to close any of the paths that overlap, FontMonger 
only computes the intersection points of the paths. It does not 
remove any of the extra segments between the intersections.
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Requirements for character outlines
• A path must not cross over itself. If you draw a path that 

crosses over itself, the character will not fill in properly when 
you try to use the font containing the character.

• All paths must be closed. If you do not close a path, 
FontMonger automatically joins the open ends with a straight 
line segment when it creates the font. This may not yield the 
desired result.

See the sections "Drawing straight line segments" and 
"Closing a path with a curve" in this chapter for details of the 
procedures for closing a path.

• A curved segment must not have a loop. It is possible to drag 
the shape handles of a curve in such a way that a loop gets 
introduced into the curve. This can cause the resulting 
character to fill incorrectly when it is built into a font.

• A path must not overlap another path. If you draw 
overlapping paths, the resulting character will not fill correctly 
when it gets built into a font. Use Merge Outlines from the 
Edit menu to remove overlaps.
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Chapter 9. Menu Reference
This chapter describes each item on FontMonger's menus and the 
dialogs associated with them.

In this chapter, menu items are named using a shorthand form: 

menu nam e: item  name 

For example, Exit on the File menu is referred to as File:Exit.

File menu — New (Ctrl+N)
New creates a new FontMonger font document and displays an 
untitled keyboard window for it.

Initially, the new font has no characters, so all the keycaps in the 
window use the System font to show the characters normally 
associated with each key. The System font characters are drawn in 
gray to indicate the absence of actual characters in the font.

You add characters to the new font by:

• Pasting characters from other fonts (see Edit:Paste).

• Importing characters from graphics files (see File:Import).

• Creating new character outlines using FontMonger's drawing 
tools (see Chapter 8).

Before attempting to build a font file, you should ensure that the 
font information is correct (see File:Build Font and Options:Set 
Font Information).

File menu — Open (Ctrl+O)
Open either opens an existing FontMonger font document file, or 
converts the contents of a font file into a new FontMonger 
document, and displays the font in a keyboard window.



When you choose Open, the Open Font dialog appears:

File Name:
| mozar2.pfb

mozar2.pfm 
wagnel. afm 
wagnel. inf 
wagnel.pfb 
wagnel. pfm

Open Font

Directories:
c:\fmonger\samples\classic
(S' c:\
(?=> fmonger 

samples 
^  classic

li ;l
| parted 1

List Files of Type: Drives:
| All Files [*.*) H i  | B e :  | j |

Fonts:

Drives
Drop down the list of drives on your system to choose the disk 
containing the font you want to open.

Directories
Choose the directory containing the font you want to open.

The full path name of the current directory is shown above the list. 
The current directory also appears in the Directories list with a 
gray "open folder" icon preceding it.

The directories above the current directory in the list are its 
"parent" directories. The directories below the current directory 
are its sub-directories. Double-click on parent directories or sub­
directories to move up or down the hierarchy of directories on 
your disk.

File Name
Choose the name of the file containing the font you want to open 
by selecting its file name in the list box or by typing its name into 
the text box.

List Files of Type
Choose one of the following file types to limit the files displayed 
in the File Name list to those having the indicated extensions:
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File Type
All Files
FontMonger
TrueType
PostScript Type 1
PostScript Type 3
Corel
LaserMaster 
Nimbus Q 
Intellifont 
All Macintosh files

Extension
all
.FRF or .FRT 
.TTF
.PFB or .NXT
.PFA or .PSO
.WFN
.LXO
.FNT
.FI
.MRF

NOTE: FontMonger cannot recognize a font file unless it has the 
correct extension as shown in the above table. I f  you have renamed 
your font files with a different extension, you must restore the 
correct extension before opening them with FontMonger.

The Fonts list shows the full names of fonts contained in the file 
selected in the File Name list.

FontMonger document files and most font files can contain only a 
single font. However, Corel, Intellifont and Macintosh font files 
may contain several fonts. Choose the font you want to open by 
selecting it in the Fonts list.

The Fonts list is empty if the selected file does not contain any 
fonts or is not a valid font file.

Close closes the active (frontmost) keyboard or Alter Character 
window within FontMonger's main window.

Closing an Alter Character window causes any alterations applied 
in the window to take effect in the font.

Closing a keyboard window closes the associated FontMonger 
font document. If the font is new (untitled), or if an existing font 
has been modified, FontMonger asks if you want to save the font 
before closing the keyboard window.

Fonts

File menu — Close (Ctrl+W)
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File menu — Save (Ctrl+S)
Save saves the font document associated with the active 
(frontmost) keyboard or Alter Character window.

After making changes to a font document, you should always save 
the font as well as build an installable font file. Saving the font 
makes it readily available in case you need to make further 
changes.

You should also use Save regularly (perhaps as often as every few 
minutes) while you are modifying a font. In the event of a power 
failure or system error, you will then only lose changes you've 
made since the last save.

If you save a new font — one with an untitled keyboard window 
— FontMonger will ask you to name the document file, as if you 
had chosen File:Save As instead.

File menu — Save As
Save As saves a font into a new font document file. When you 
choose Save As, the Save As dialog appears:

m
File Name:

b a c h b lO .U f
b a ch b 1 1 .tif
bach o S .ttf
b ach r1 2 .ttf
b o le rl Uf
h a n d e2 .tif
h an d e3 .ttf
h a n d e4 .U l

Directories: j .. .... j

c:\fmonger\samples\ciassic

lr^ c :\
B  fmonger 
£> samples

Save File as Type: Drives:
| FontMonger (.FRF) |f&l| | Hal c:

Drives
Drop down the list of drives on your system to choose the disk 
onto which you want to save the font.

Directories
Choose the directory into which you want to save the font.
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The full path name of the current directory is shown above the list. 
The current directory also appears in the Directories list with a 
gray "open folder" icon preceding it.

The directories above the current directory in the list are its 
"parent" directories. The directories below the current directory 
are its sub-directories. Double-click on parent directories or sub­
directories to move up or down the hierarchy of directories on 
your disk.

File Name
Enter the name you want to use for the document file. You can use 
any name you wish — the name doesn't have to reflect the font's 
full name, since the full name is stored within the document file, 
but the file name is limited to 8 characters.

There's no need to enter an extension in the File Name text box. 
FontMonger supplies the correct extension for you automatically.

Save File as Type
Choose one of the FontMonger document file types:

• normal FontMonger document files have extension .FRF

• FontMonger template document files have extension .FRT

Template documents are identical in format to normal document 
files. However, when you open a template font document, 
FontMonger automatically makes a copy of the font, leaving the 
template document file untouched.

File menu — Revert to Saved
Revert to Saved discards any changes you have made to a font 
since the last time it was saved.

You cannot revert a font until it has been saved at least once.

File menu — Convert Batch (Ctrl+B)
Convert Batch converts a group of fonts in any format to a new 
format. It can also convert fonts into FontMonger document files.
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When you choose Convert Batch, the Convert Batch dialog 
appears:

Fonts in Batch:

FontMonger

Convert jj

Cancel ^

|: Clear Batch | 1 & « -■  ■ 1 1 Rod... J

New Format:

| Remove |

Fonts in Batch
The Fonts in Batch list shows you the fonts that are currently in 
the batch.

The first time you use Convert Batch, the list is empty, and you 
use the Find and Add buttons to construct a batch.

The next time you use Convert Batch, the list contains the fonts 
that you previously placed in the batch. You can add more fonts 
to the batch, or remove fonts from the batch with Remove or 
Clear Batch.

Fonts that have already been converted are listed with a number 
preceding their name. This is the same number that appears as 
part of the converted font's file name, so you can easily relate 
fonts in the list to files that were created.

Fonts without a number have not been converted yet.

Clear Batch
Choose Clear Batch to remove all fonts from the batch.

Remove
Choose Remove to remove fonts selected in the Fonts in Batch list 
from the batch.

FontMonger User Guide



New Format
Choose one of the formats that FontMonger can convert to:

FontMonger .FRF FontMonger documents
TrueType .TTF Windows 3.1 TrueType fonts
Type 1 .PFB PC PostScript Type 1 fonts
Type 3 .PFA PC PostScript Type 3 fonts
Nimbus Q .FNT Nimbus Q fonts
TrueType for Mac .MRF System 7 TrueType fonts
Type 1 for Mac .MRF Macintosh PostScript Type 1 fonts
Type 3 for Mac .MRF Macintosh PostScript Type 3 fonts
Type 1 for NeXT .NXT NeXT PostScript Type 1 fonts

Add
Choose Add to add a single font to the batch. The Add to Font 
dialog appears:

FQe Name:

List Files of Jype:

Fonts:mmMEiuHsn

Add To Batch

Directories:
c: \fmonger\samples\classic

OR

cA
fmonger 

£> samples 
&  classic

Drives:
| Type 1 f.PFB, .NXT) a

This dialog is identical to the Open Font dialog, except that when 
you choose OK, the selected font is added to the batch instead of 
being opened. See File:Open for more information.
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Find
Choose Find to search a single directory, multiple directories or 
an entire disk for fonts in formats which FontMonger can read. 
The Choose Directory dialog appears:

Find fonts in directory: 
c: \ftnonger\samples

Directories:

I °K I
r  Cancel I

c :\
(r=» fmonger

n  classic

Drives:

GEl c: a
] include sub-directories

Drives

Drop down the list of drives on your system to choose the disk 
containing the directory you want to search.

Directories

Choose the directory you want to search for fonts.

The full path name of the current directory is shown above the 
list. The current directory also appears in the Directories list 
with a gray "open folder" icon preceding it.

The directories above the current directory in the list are its 
"parent" directories. The directories below the current 
directory are its sub-directories. Double-click on parent 
directories or sub-directories to move up or down the 
hierarchy of directories on your disk.

Include sub-directories

Choose this option to include all sub-directories of the chosen 
directory in the search. If you don't choose this option, 
FontMonger skips over the files in the sub-directories when 
searching the chosen directory.

To search an entire disk, choose the root directory (the top 
directory) in the Directories list, and choose the Include sub­
directories option.
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When you choose OK, FontMonger searches your chosen 
directory, and its sub-directories if requested, for fonts.

At the completion of the search, a dialog appears, showing the 
fonts that were found:

Fonts Found: | A ddSelectedj

11111
♦

O List by £ile 

<§> List by Font

List Fonts of Jype: |AII Formats |±|

Fonts Found

The Fonts Found list shows file names or full font names of all 
the fonts that FontMonger found during the search.

Initially, every item in the list is selected, so you can quickly 
add them to the batch by choosing Add Selected. If you don't 
want to add all of the fonts, adjust the selection so that only 
the fonts you want are selected.

List Fonts of Type

To limit the fonts shown in the Fonts Found list, choose a font 
type from the List Fonts of Type list.

If you choose an entry other than All Formats, then only the 
selected fonts of the chosen format will be added to the batch 
when you choose Add Selected.

List by File

Choose this option to show file names in the Fonts Found list. 
If FontMonger found more than one font in a single file, the 
font name will appear several times in the list — once for each 
font found.

List by Font

Choose this option to show full font names in the Fonts Found 
list.
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Add Selected

Choose Add Selected to add the fonts selected in the Fonts 
Found list to the batch.

Convert
Once you've constructed a batch of fonts, choose Convert. The 
Choose Directory dialog is displayed:

| Pul converted fonts in directory: |' ; ~' |
I c:\fmonger\samples\classic . ...........„
I 1 Cancel r ]
| Directories: Drives:

&  c:\ | B c :  [S j
fmonger 

£> samples 
(r=> classic

I Rew P.iiectari! I

Drives

Drop down the list of drives on your system to choose the disk 
where you want to save the converted files.

Directories

Choose the destination directory into which you want to place 
the converted files.

New Directory

Choose New Directory if you want to create a new directory 
for the converted files, then enter a name for the new directory 
in the New Directory dialog.

When you choose OK in the Choose Directory dialog, the 
conversion process begins. During conversion, FontMonger 
displays a progress indicator showing how many fonts remain to 
be converted.

You can interrupt the conversion process at any time by choosing 
Stop. Files for the fonts that have already been converted can be 
found in the destination directory.
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menu — Build Font (Ctrl+F)
Build Font creates a font file that you can install into Windows or 
your type management software.

You build a font file whenever you have made changes to a 
FontMonger font document and are ready to install those changes 
into your system.

NOTE: If you need to build a number o f font files, you may find it 
more convenient to convert them as a batch to the appropriate 
format instead o f building them individually. See File:Convert 
Batch for more information about batch conversions.

When you choose Build Font, the Build Font dialog appears:

File Name:
a
bachb10.tif
bachb11.Mf
bacho9.tif
bachr12.Uf
bolerl.ttf
hande2.tif
handeS.Uf
hande4.Hl

Directories:
c: \f roonger\samples\classic

Save File as Type: 
I TrueType |.TTF) 13

I c: \
fmonger 

0^ samples 
classic

Drives:

I «  I
I . Cancel 1

This dialog is identical to the Save Font dialog (see File:Save As) 
except that you choose a font file format instead of a FontMonger 
document type. The font file formats are:

TrueType .TTF Windows 3.1 TrueType fonts
Type 1 PFB PC PostScript Type 1 fonts
Type 3 .PFA PC PostScript Type 3 fonts
Nimbus Q .FNT Nimbus Q fonts
TrueType for Mac .MRF System 7 TrueType fonts
Type 1 for Mac .MRF Macintosh PostScript Type 1 fonts
Type 3 for Mac .MRF Macintosh PostScript Type 3 fonts
Type 1 for NeXT .NXT NeXT PostScript Type 1 fonts
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File menu — Import Character (Ctrl+I)
Import Character imports the contents of a graphics file into a font 
as a character. You must select a single keycap in the font's 
keyboard window to be associated with the imported character.

You can import graphics files in the following formats:

• Adobe Illustrator (AI) document files from any version of 
Windows or Macintosh Illustrator (since version 1.1), or from 
CorelDraw, Micrografx Designer and Art & Letters.

• Encapsulated PostScript (EPS) files from Illustrator.

• Encapsulated PostScript (EPS) files from CorelDraw.

You can also import EPS files from a number of other applications. 
However, since the format of EPS files varies widely between 
applications, you should experiment with the applications you 
want to use to find out if they're compatible with FontMonger.

When you choose Import Character, the Import Character dialog 
appears:

Drives
Drop down the list of drives on your system to choose the disk 
containing the graphics file you want to import.

Directories
Choose the directory containing the file you want to import. 

See File:Open for more information on using this list.
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File Name
Choose the name of the file you want to import by selecting its file 
name in the list box or by typing its name into the text box.

List Files of Type
Choose one of the following file types to limit the files displayed 
in the File Name list to those having the indicated extensions:

File Type Extension
All Files all
Adobe Illustrator .AI
Encapsulated PostScript .EPS
All Macintosh files .MRF

menu — Export Characters) (Ctrl+E)
Export Character(s) allows you to export some or all of the 
characters in a font into a graphics file. You may do this to:

• embellish characters and use them as artwork

• edit the character outlines and import them back into the font 
(although you may find FontMonger's built-in drawing tools 
more convenient).

When you choose Export Character(s), the Export Character 
dialog appears:

j <§> Export all characters in font 

j O  Export the following text:
L - J S - i  1
| Cancel' |

] O  Character outlines only Sjze: 1250 | points 
j ®  Filled characters

Export all characters in font
Choose this option to export all the characters in the font into a 
single graphics file.
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Export the following text
Choose this option to export only the characters you enter in the 
text box.

If you want each character in a separate file, you must export each 
character separately.

Character outlines only
Choose this option to format the exported characters with a stroke 
around their edges. The interior of the character paths are unfilled.

Filled characters
Choose this option to format the exported characters with a solid 
black fill. (The inner paths of the character are filled with white 
instead.)

Size
Enter the point size you want for the exported characters.

When you export a single character, you should use the default 
value of 250 points. But if you export many characters, you should 
decrease the point size so that the exported characters will fit in 
the graphic image that FontMonger creates.

Once you have selected the formatting options, choose OK to 
bring up a dialog in which you name the new graphics file:

File Nante:

bachb10.tif
b a ch b ll.ttf
bacho9.Uf
bachr12.Kf
bolerl Uf
hande2.Uf
hande3.tif
hande4.tif

Save File as lyp e :___________
I Illustrator 1.1 for PC I A lls]

Directories:
c:\fmonger\samples\classic

(S'c:̂
£ 3  fmonger 
£ 3  samples 
£ 3  classic

Drives:

I Catyjei. ~1

a

This dialog is identical to the Save Font dialog (see FileiSave As), 
except that you choose a graphics file format instead of a 
FontMonger document format. You can export in the following 
formats:
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Format Extension
Adobe Illustrator .AI
Encapsulated PostScript .EPS
Windows Metafile .WMF

File menu — Print (Ctrl+P)
When the active keyboard window is in the keyboard layout view 
(see Options:Keyboard Layout), Print prints a diagram that you 
can use to locate characters on your keyboard.

You'll find keyboard layout diagrams useful when you're using 
your fonts with other applications, especially if you've rearranged 
the fonts in a non-standard way.

The printed output consists of two parts:

• A keyboard layout showing you the characters associated with 
the unshifted, Shift, Ctrl+Alt and Shift+Ctrl+Alt modifier 
combinations. Each key position in the layout is arranged as 
follows:

Shift Shift+Ctrl+Alt

unshifted Ctrl+Alt

• A list of any characters that are associated with other modifier 
combinations, including dead keys if your keyboard 
configuration has them.

When the active keyboard window is in the character chart view 
(see Options:Character Chart), Print prints the entire character 
chart.

File menu — Print Setup
Print Setup lets you configure your printer before printing begins.

When printing keyboard layouts on standard paper sizes, you 
should normally choose landscape rather than portrait orientation, 
since the layout diagram fits the page better in landscape 
orientation.
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Consult your Windows documentation for more information 
about using the options in the Print and Print Setup dialogs.

File menu — Exit
Exit exits from the FontMonger application. If you have windows 
open with any unsaved changes to fonts, FontMonger gives you 
the option of saving each font before exiting.

Edit menu — Undo (Ctrl+Z)
Undo reverses up to the last eight actions you performed in an 
Alter Character window. Eight actions are remembered for each 
window.

You can only undo actions that modify the character data. 
Environmental changes such as zooming in or out, or scrolling the 
display, cannot be undone with Undo.

The text of the Undo menu item changes to show you the last 
action you performed.

Edit menu — Redo (Ctrl+Y)
Redo reapplies changes that you have reversed with Undo.

You can mix Undo and Redo to step forwards or backwards 
through your last eight changes, but once you perform any new 
action, any undone change can no longer be redone.

The text of the Redo menu item changes to show you the next 
action that can be redone.

Edit menu — Cut (Ctrl+X)
In a keyboard window, Cut removes the selected characters from 
the font and places them on the clipboard — ready to be pasted 
into different character positions or into another font if you wish.

In an active text box of a dialog or the Alter Character window, 
Cut deletes the selected text and places it on the clipboard.

When editing outlines in the Alter Character window, Cut deletes 
the selected segments from the character and places them on the 
clipboard.
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Edit menu — Copy (Ctrl+C)
In a keyboard window, Copy places the selected characters from 
the font on the clipboard without changing the font.

In an active text box of a dialog or the Alter Character window, 
Copy places the selected text on the clipboard.

When editing outlines in the Alter Character window, Copy 
places the selected segments of the character on the clipboard.

Edit menu — Paste (Ctrl+V)
In a keyboard window, Paste places the characters from the 
clipboard into the font.

• If keycaps are selected in the window, Paste replaces the 
characters on the selected keys with the characters on the 
clipboard.

• If no keycaps are selected, Paste replaces the characters at the 
keyboard positions that the clipboard characters were 
originally copied from, even if they were copied from another 
font.

In an active text box of a dialog or the Alter Character window, 
Paste replaces the selected text with the text on the clipboard.

When editing outlines in the Alter Character window, Copy adds 
the segments on the clipboard to the character.

Edit menu — Delete (Del)
In a keyboard window, Delete removes the selected characters 
from the font.

In an active text box of a dialog or the Alter Character window, 
Delete deletes the selected text. If no text is selected, Delete 
deletes the text character immediately after the flashing insertion 
point.

When editing outlines in the Alter Character window, Delete 
deletes the selected segments from the character.
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Edit menu — Select All (Ctrl+A)
In a keyboard window, Select All selects all keycaps:

• In the keyboard layout view (see Options:Keyboard Layout), 
Select All selects all keycap positions that can be accessed 
from the keyboard. This includes dead keys, but does not 
include any characters that are only accessible with 
Alt+numeric keypad combinations.

• In the character chart view (see Options:Character Chart), 
Select All selects all 256 keycap positions.

In an active text box of a dialog or the Alter Character window, 
Select All selects all the text in the text box.

When editing outlines in the Alter Character window, Select All 
selects all segments in the character.

Edit menu — Select 0-9 

Edit menu — Select a-z 

Edit menu — Select A-Z
These three menu items select the keycaps corresponding to the 
listed ranges of characters.

You can add your own selection ranges to the menu by using 
Edit:Customize Range.

Edit menu — Customize Range
Customize Range lets you define ranges of characters that can be 
selected in a single operation. Your customized ranges appear on 
the Edit menu along with the three built-in ranges supplied with 
FontMonger.
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When you choose Customize Range the Customize Selection 
Range dialog appears:
u 31 v  ̂ -Custbirnize Selection Range

Saved Selection Ranges: " Customization: ~ 1...... < * .... 1
0-9
A-Z
a-z

O Update 
<§> New 
O Rename 
O Ctrl+Key 
O Delete

| Cancel jj

|  Name: | Special Characters) |

Saved Selection Ranges
This list shows the selection ranges that have already been 
defined. When performing a customization other than creating a 
new range, select the name of the range you want to affect.

Customization
Choose one of the five customization actions:

• Update redefines an existing selection range.

• New creates a new selection range.

For both Update and New, you must select the characters that 
you want to form the range in a keyboard before you choose 
Customize Range.

• Rename changes the name of an existing selection range.

• Ctrl+Key assigns a keyboard shortcut to any existing selection 
range. (You can also assign a keyboard shortcut while creating 
or renaming a range.)

You can use the Ctrl key in combination with any of the 
numbers 0-9 as keyboard shortcuts.

• Delete removes an existing selection range. You can remove 
the three built-in ranges if you wish.

Name
Enter the name of a selection range that you are creating or 
renaming.
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Ctrl+Key
Enter a number from 0 to 9 for use as a keyboard shortcut (in 
conjunction with the Ctrl key) for the selection range.

Edit menu — Merge Outlines
Merge Outlines provides one way of resolving the potential 
problems caused by paths that overlap in a character outline.

When you are editing outlines in an Alter Character window, 
Merge Outlines examines the character for paths that overlap, 
computes the points where the overlapping paths cross, then 
removes the fragments of the paths within the overlapping region.

The result is a character having the same shape as before, but 
without any overlapping paths.

NOTE: A font containing characters with overlapping paths will 
not display or print correctly when you install it in your system.

Edit menu — Remove Character(s) (Ctrl+R)
Remove Character(s) removes the association between a keycap 
and the character it currently displays.

The effect is similar to deleting a character (see Edit:Delete) — the 
character is no longer accessible from that key — but the character 
is not deleted from the font.

Use EditrChoose Character if you want to assign the character to 
the same or another keycap.

Edit menu — Choose Character (Ctrl+K)
In a keyboard window, Choose Character lets you pick any 
character in the font and assign it to a keyboard position. You use 
Choose Character to gain access to the unencoded characters in 
your fonts, as well as characters that you've removed from the 
keyboard.

In the Components, Fraction Top, Fraction Bottom or Context
text boxes of an Alter Character window, Choose Character lets 
you insert any character from the font into the text box for use as a 
component or context character.
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In either case, you choose the character from the Choose Character 
dialog:

The Characters in Font list shows every character in the font in a 
four-column format. Below each character is its character name, 
which helps you distinguish between characters. The character 
name is underlined if the character is not currently assigned to 
any keyboard position.

NOTE: If, for  a particular keyboard position in a keyboard window, 
you choose a character that has already been assigned to another 
keycap, FontMonger will create a temporary copy o f the character 
for the new keyboard assignment. I f  you bring up the Choose 
Character dialog again, you will see both copies o f the character.

Options Menu — Keyboard Layout
Choose Keyboard Layout to place a keyboard window in the 
"keyboard layout view":
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The menu item is checked when the window is in the keyboard 
layout view.

Options Menu — Character Chart
Choose Character Chart to place a keyboard window in the 
"character chart view." The menu item is checked when the 
window is in the character chart view.

In this view, the window shows all 256 characters in the Windows 
ANSI character set:

m E tm v m & B S d B S g i I]-t |

- F o n t  H&ndfcl

0 1 2 3 A 5 6 7 8 9 A B C D E F ♦

6 j
M j y M i M j j S i h j j i J J

j j j j m | j U M i
096 097 098 099 0100 0101 0102 0103 0104 0105 0106 0107 0108 0109 0110 0111

7
M i J l x l M J J M l

v j w ] x i j d j j j j l { 1 j j j i X .
0112 0113 0114 0115 0116 0117 0118 0119 0120 0121 0122 0123 0124 0125 0126 0127

8 J j i . t J } if X i M J & J J ■ ' I d 1 | 1
J J

0128 0129 0130 0131 0132 0133 0134 0135 0136 0137 0138 0139 0140 0141 0142 0143

9 j j J  ̂ ■ ■ itft S i S i -f - j j
-
j j J O j i p e f JJ i l l * !

0144 0145 0146 0147 0148 0149 0150 0151 0152 0153 0154 0155 0156 0157 0158 0159 -

A j :~r |
j j S i i l t t f i j I f JJ i ”

0 i i j j A
« r(

0160 0161 0162 0163 0164 0165 0166 0167 0168 0169 0170 01711 0172 0173 0174 0175 ♦

The number below each character is the sequence of digits you 
type on your numeric keypad, with the Alt key held down, to 
access each character in the character set.

If your screen is not big enough to show the entire chart, you can 
scroll the window to see the rest of the characters.

Options Menu — Show System Font
Show System Font controls how FontMonger displays characters 
on keycaps in a keyboard window and within the Composite, 
Fraction Top, Fraction Bottom and Context text boxes of the Alter 
Character window.

Normally, FontMonger shows characters in these places using its 
own built-in fonts that are based on the standard U.S. System font 
layout.
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Choose Show System Font if your System font is significantly
different from the U.S. System font and you are having trouble
relating characters to their normal keyboard positions.

When Show System Font is not checked:

• In a keyboard window, FontMonger shows characters on 
keycaps using the font you opened. Keycaps with no assigned 
character show a gray character from FontMonger's built-in 
font.

This built-in font is similar to the standard U.S. Windows 
System font, but can represent uniquely all 256 characters in 
the Windows ANSI character set.

• In an Alter Character window, FontMonger shows characters 
in the text boxes using its built-in font.

When Show System Font is checked:

• In a keyboard window, FontMonger uses your actual System 
font on all keycaps.

• In an Alter Character window, FontMonger uses your 
system's standard sans-serif font.

Options Menu — Set Font Information
Set Font Information calls up a dialog which shows descriptive
information for the font in the active keyboard window:

Family Name: OK
|RMH1

Cancel
Font Style/Weight Name:
Regular

Stroke Weight:
Font Width:

Family Relationship:

Family Metrics: 
Ascent: [o~
Descent: |0 

Line Gap: |0

Regular a
Normal US
Plain member na

GlZI
~ Font Classification:' 

13 Sans-serif 
D Decorative
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Family Name
This is the common base name of a group of related fonts. If you 
want to construct a family of fonts, they must all have exactly the 
same family name.

When you examine the font information for a font that 
FontMonger has converted from a font file, you may find that the 
family name contains hyphens or is missing spaces between 
words. This causes no harm, but you may edit the name to 
improve its appearance if you wish.

Every FontMonger document must have a family name in order to 
be usable. If you try to build a font file from a font document that 
does not have a family name, FontMonger will display the Set 
Font Information dialog so that you can enter a name.

Font Style/Weight Name
This is the part of a font's name that distinguishes different fonts 
in the same family. Each member of the family should have a 
different name.

You can enter any name you want in this text box, but the 
traditional names (regular, bold, italic and bold-italic) are 
recommended.

If you do not enter anything in the Font Style/Weight Name text 
box, FontMonger will automatically use "Regular" when you 
build the font into a font file.

Stroke Weight
This drop-down list describes the stroke weight of a font — that is, 
the relative thickness of the upright parts of characters like H  and 
I.

When you create or modify a font, choose the list entry that best 
describes the stroke weight of your font. If you're not certain of 
the best stroke weight to use, choose Regular or Unknown.

Currently, Stroke Weight is significant only for Windows 
TrueType fonts.

Font Width
This drop-down list describes the overall "proportions" of a font, 
compared to a "normal" font.
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A font whose characters are narrower than normal is called 
condensed (or compressed). A font with wider characters is called 
expanded (or extended).

When you create or modify a font, choose the list entry that best 
describes the overall proportions of your font. If you're not certain 
of the best font width to specify, choose Normal or Unknown.

Currently, Font Width is significant only for Windows TrueType 
fonts.

Family Relationship
This drop-down list shows you whether a font is a member of a 
family of fonts. When you create or modify a font, you should 
ensure that an appropriate list entry is chosen.

Every family must have a "plain" member, which is usually a font 
whose stroke weight is Regular and whose font width is Normal.

Other family members are optional, with Bold, Italic and Bold- 
Italic being the most common. FontMonger lets you choose these 
relationships explicitly. If a family has any other members, you 
should choose Other family member for each of them.

If a font is not a member of a family, you must choose Plain 
member from the list.

Family Metrics
The ascent, descent and line gap of a font are, respectively, the 
height of a font's lowercase letters with ascenders (such as b, d and 
h), the depth of a font's lowercase letters with descenders (such as 
p, q and y), and the amount of extra space to insert between lines 
of text formatted in the font.

FontMonger normally determines appropriate values for these 
three font metrics, so you can usually leave the Ascent, Descent 
and Line Gap text boxes set to zero.

If you want exactly the same metrics for all members of a family of 
fonts, you should not rely on FontMonger's automatic 
determination, since the differences in font design between family 
members will affect the results. Instead, you should enter the 
same values in the Ascent, Descent and Line Gap text boxes for 
each member of the family.
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The values in these text boxes are specified in Vioooths of the font's 
point size.

Sans-serif
The Sans-serif option indicates whether a font was designed 
without serifs.

When you create or modify a font, you should ensure that the 
Sans-serif option reflects the actual font design.

Currently the option is significant only for Windows TrueType 
fonts. Its only purpose is to permit Windows to make reasonable 
decisions about whether the font can be substituted for another 
font that is referred to by a Windows application but is missing 
from your system.

Decorative
The Decorative option indicates whether a font has a normal 
alphabetic character set or whether it consists of non-alphabetic 
characters such as dingbats, music symbols, map symbols and so 
on.

When you create or modify a font, you should ensure that the 
option reflects the actual font design.

Currently, the Decorative option is significant only for Windows 
TrueType fonts. Some word processors treat decorative fonts 
differently from normal fonts, letting you access their characters 
via numeric codes.

Options Menu — Set Font Protection
Set Font Protection displays a dialog which allows you to 
examine and possibly change the information within a font that 
protects it from unauthorized use:

Copyright Notice:

| C&beirl |

®  No protection
O Read-only encapsulation allowed 
O No encapsulation allowed
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Copyright Notice
The Copyright Notice text box shows you the copyright 
information that is stored within a font.

You cannot change the copyright notice in a font that you did not 
create in FontMonger (using File:New).

No protection
Read-only encapsulation allowed 
No encapsulation allowed
These three options control whether the font may be embedded in 
documents transferred between different computers.

• No protection: The font may be embedded in documents 
without restriction. When a document is transferred to another 
computer, the font may be installed on that computer and 
retained even after the document has been discarded.

• Read-only encapsulation allowed: The font may be 
embedded in documents for the sole purpose of viewing those 
documents on another computer. When the documents are 
discarded, the fonts may not be retained.

• No encapsulation allowed: The font may not be embedded in 
any document.

The protection options are significant only for Windows TrueType 
fonts.

Options Menu — Snap to Guide Lines
In an Alter Character window, horizontal and vertical guide lines 
allow you to align characters or character parts precisely.

When Snap to Guide Lines is checked, the elements you drag will 
"snap" or jump to the exact guide line position when they come 
within a short distance of the position.

When Snap to Guide Lines is unchecked, the guide lines still 
appear in the window, but do not have any effect on dragging.
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Alterations menu — Normal
Normal removes any alterations you have previously applied to 
the character in an Alter Character window, or to the selected 
characters in a keyboard window.

Alterations menu — Small Caps 

Alterations menu — Slant 

Alterations menu — Superior 

Alterations menu — Inferior
These built-in alterations provide the most common modifications 
to characters. Each has a different effect on character size, slant 
and placement:

Alteration Horizontal
Scale

Vertical
Scale

Vertical
Position

Slant
Angle

Small Caps 65% 60% normal none

Slant 100% 100% normal 13° to right

Superior 65% 60% 400 units
above
baseline

none

Superior 65% 60% 200 units
below
baseline

none

Alterations menu — Customize Alteration
Customize Alteration lets you define your own alterations that 
appear on the Alterations menu.
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When you choose Customize Alteration the Customize Alteration 
dialog appears:

Saved Alterations:

Slant
Superior
Inferior

Small Caps

O Rename 
O Ctrl+Key 
O Delete

Name: | New Alteration | Ctrl+| |

Saved Alterations
This list shows the alterations that have already been defined. The 
first four entries are the built-in alterations, followed by the 
custom alterations you have created. When performing a 
customization other than creating a new alteration, select the 
name of the alteration you want to affect.

Customization
Choose one of the five customization actions:

• Update redefines an existing alteration.

• New creates a new alteration.

For both Update and New, you must set up the scale, position, 
slant and rotation you want to use before you choose 
Customize Alteration.

• Rename changes the name of an existing alteration.

• Ctrl+Key assigns a keyboard shortcut to any existing 
alteration. (You can also assign a keyboard shortcut while 
creating or renaming an alteration.)

You can use the Ctrl key in combination with any of the 
numbers 0-9 as keyboard shortcuts.

• Delete removes a custom alteration.

You cannot remove a built-in alteration. However, if you select 
a built-in alteration from the Saved Alterations list the menu 
item changes to Reset, and you can reset the selected built-in 
alteration to its default definition.
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Name
Enter the name of an alteration that you are creating or renaming. 

Ctrl+Key
Enter a number from 0 to 9 for use as a keyboard shortcut (in 
conjunction with the Ctrl key) for the alteration.

Alterations menu — Alter Character(s)
Alter Character(s) opens an Alter Character window for the 
character selected in a keyboard window (or the first selected 
character, if several are selected).

You can also open an Alter Character window by selecting a 
keycap and pressing Enter, or by double-clicking on a keycap.

Alterations menu — Previous Character (Ctrl+left arrow) 

Alterations menu — Next Character (Ctrl+right arrow)
Previous Character and Next Character change the character 
displayed in an Alter Character window, by switching to a 
different character in the font.

Switching to another character is a quick way to get the effect of 
closing the Alter Character window and opening another one for a 
different character.

• If there are no characters selected in the font's keyboard 
window, Previous Character and Next Character switch to the 
previous or next character in the font, in alphabetical order 
according to the character name.

• If there are characters selected in the keyboard window, 
Previous Character and Next Character switch to the previous 
or next character in the selection.

You can also switch to another character by simply typing the 
character you want (provided that there is no active text box in the 
Alter Character window).

If you accidentally switch characters, you can return to the 
original character by using Edit:Undo.

FontMonger User Guide



Window menu — Black and White
Black and White changes the way FontMonger displays keyboard 
and Alter Character windows, if you have a color or gray-scale 
screen.

By default, FontMonger uses color and gray levels to enhance the 
appearance of these windows.

If your screen does not provide enough contrast between the dark 
and light colors, keycaps and other window elements may be hard 
to read.

Choose Black and White to force FontMonger to use high-contrast 
black and white images in the keyboard and Alter Character 
windows.

Window menu — Cascade
Cascade rearranges all the keyboard and Alter Character 
windows in a staggered or "cascading" pattern of overlapping 
windows.

This is a standard Windows window-management function.

Window menu — Tile
Tile rearranges all the keyboard and Alter Character windows in 
a grid-like arrangement of non-overlapping windows.

This is a standard Windows window-management function.

Window menu — Window list
The names of all keyboard and Alter Character windows are 
shown at the bottom of the Window menu. You can activate any 
window, bringing it in front of all other FontMonger windows, by 
choosing its name from the menu.

This is a standard Windows window-management function.
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Help menu — Contents
Contents displays a help window that contains a list of the main 
topics for which you can get help within FontMonger.

The help window is controlled by the standard Windows Help 
application, and so has its own menus. Choose Help:How to Use 
Help for more information about using the Help application.

Help menu — Search for Help On
Search for Help On also displays a help window, and also allows 
you to immediately start searching for help topics that contain 
specific key words.

Help menu — How to Use Help
How to Use Help explains how to use the Windows Help 
application to get help about FontMonger.

Help menu — About FontMonger
About FontMonger displays a dialog that shows the version of 
FontMonger that you are running.

Before you contact Ares Customer Support with questions about 
FontMonger you should make a note of the version number you 
are using.
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Appendix A . Font Vendors
Adobe Systems, Inc.
1585 Charleston Road 
Mountain View, CA 94039
800-833-6687
Agfa Division of Miles, Inc.
90 Industrial Way 
Wilmington, MA 01887
800-424-TYPE
Bitstream, Inc.
Athenaeum House 
215 First Street 
Cambridge, MA 02142
800-237-3335
Casady & Greene, Inc.
22734 Portola Drive 
Salinas, CA 93908-1119
800-359-4920
Digital Typeface Corp.
9965 West 69th Street 
Eden Prairie, MN 55344
800-947-8880
Font Haus, Inc.
15 Percy Avenue 
Norwalk, CT 06850
800-942-9110
Headliners International
720 White Plains Road 
Scarsdale, NY 10583
800-346-8815
International Digital Fonts
1431 6th Street Northwest 
Calgary, Alberta T2M 3E7 
Canada
403-284-2288
ImageClub Typeface Library
102 11th Street SE, #5 
Calgary, Alberta T2G 3G2 
Canada

Lanston Type Co. Ltd
Giampa Textware Corp.
1340 East Perder Street 
Vancouver, BC V5L 1V8 
Canada
800-663-8760
Letraset
40 Eisenhower Drive 
Paramus, NJ 07653
800-343-TYPE
Linotype-Hell Company
425 Oser Avenue 
Hauppauge, NY 11788
800-633-1900
Monotype Typography
Suite 504
53 West Jackson Boulevard 
Chicago, IL 60604
800-666-6897
Precision Type
47 Mall Drive 
Commack, NY 11725
800-248-3668
The Font Company
7850 East Evans Road, Suite 111 
Scottsdale, AZ 85260
800-442-FONT
The Font Shop
800-36FONTS
The Stone Type Foundry
644 Emerson Street, Suite 10 
Palo Alto, CA 94301
415-324-1870
Treacyfaces, Inc.
I l l  Sibley Avenue 
Ardmore, PA 19003
215-896-0860

800-661-9410





Appendix B. Customer Support
Ares Software Corp. provides telephone technical support for 
FontMonger between 8:30am and 5:30pm Pacific Time, Monday 
through Friday.

The technical support phone number is (415) 5 7 8 -9 0 9 0 .

Before calling Customer Support
When you install FontMonger you should complete the 
information on this and the following page. If you call customer 
support you will need all the following information:

FontMonger serial number . F W - 17515___________________
Your serial number is on the FontMonger Program Disk.

Your computer system
Manufacturer______________________________________________

Model num ber_____________________________________________

Total RAM ________________________________________________

Total expanded/expanded memory _________________________

Available disk space________________________________________

Display typ e_______________________________________________

Is your computer on a network?_____________________________

Your printer
Manufacturer ____________________________________________

Model num ber_____________________________________________

Memory capacity___________________________________________

Is your printer on a network? _______________________________

Software
Version of DOS ____________________________________________

Version of W indows_______________________________________

Standard or Enhanced m ode?_______________________________



Version numbers of applications for which you are 
converting/modifying fonts.
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ARES FontMonge
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For Converting, Enhancing and Modifying Typefaces.

FontMonger software converts fonts in any direction 

between PostScript Type 1 (for use in Adobe Type 

Manager ) , PostScript Type 3, Nimbus Q (for use in 

SoftType and Geoworks Ensemble), and TrueType 

(for use in Windows 3.1). FontMonger also converts 

Intellifont fonts (from Agfa or Hewlett Packard) into 

any of the other formats. Converted fonts can be 

saved for IBM PC and compatibles, Apple 

Macintosh and NeXT too! 

FontMonger's proprietary hinting technology 

automatically adds hinting during the conversion 

process to insure the highest quality PostScript Type 1 

fonts or TrueType fonts. 

FontMonger even lets you modify character outlines. 

You can use FontMonger's built in drawing tools to 

make the modifications directly, or you can import EPS 

or Adobe Illustrator files, so you can embed simple 

graphics created in your favorite drawing or 

illustration program directly into your font. If you 

prefer, you can export characters to your drawing 

program to add embellishments and special effects. 

The type modification tools in FontMonger offer a 

unique range of capabilities including: access to 

unencoded characters, generation of superscript and 

subscript characters, creation of composite characters, 

and generation of slash and bar fractions. 

FontMonger lets you merge characters from several 

fonts. Relocate characters on the keyboard to 

locations that make sense to you. 

System Requirements: 

• Microsoft Windows 3.0 or greater

• Intel 286, 386, or 486 IBM PC or compatible

• 2 Megabytes of memory

• Hard disk and floppy drive

• Scalable outline fonts in TrueType, PostScript Type 1,

PostScript Type 3, Intellifont, or Nimbus Q format

Ares Software Corporation is a trademark and FontMonger is a trademark registered 

in the USA of Ares Software Corporation Adobe, PostScript and Adobe Illustrator are 

registered trademarks and Adobe Type Manager is a trademark of Adobe Systems, Inc. 

TrueType is a trademark and Apple and Macintosh are registered trademarks of Apple 

Computer Inc. Microsoft is a registered trademark and Windows is a trademark of 

Batch convert between PostScript Type 1, 

PostScript Type 3, Nimbus Q, and Truetype in 

any direction or convert Intellifont fonts into 

any other format. 

With Ares FontMonger you can combine 

several typefaces, remap keyboard 

characters or convert between formats. 

Modify your existing typefaces into small 

caps, obliqued characters, fractions, composite 

characters, superscripts and subscripts. 

Ares Software Corporation 

P.O. Box 4667 

Foster City, CA 94404-4667 
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